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Welcome to BellSouth® FastAccess®
DSL Wireless HomeNetworking Service!

This guide was designed to help you install the software and hardware used for
BellSouth FastAccess DSL HomeNetworking Service quickly and easily. It is very
important that you follow the step-by-step instructions in order. Please do
not skip any of these steps, even if you are already very experienced with
installing software.

For Your Records

Your User ID @bellsouth.net

Your Password

Your e-mail address @bellsouth.net

Your HomePortal Key Code:

5257 - 2574 - 6266 - 22AS - B2DC

BellSouth FastAccess Help Desk 1-877-263-2421
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BellSouth FastAccess Internet Service Kit

Please check the contents of your BellSouth FastAccess kit before you begin.
Please call 1-877-263-2421 if there are any components that are missing or
damaged. Please follow the step-by-step instructions enclosed for a successful
installation.

Your BellSouth FastAccess kit contains the
following items:

FastAccgss

1-Wall Mounted 4- Phone Installation

Phone Filter Line Filters Wizard CD
(Blue CD)

2Wire HomePortal Kit Home Network Adapter Kit

P N (optional purchases)

PCl HomePNA Card

3 N
!
| - H'"“
= T ¥
L Power Adapter !
T (black) \
HomePNA Port
. (Standard RJ-11 Telephone Port)
-
HM"H
= L HomePortal
i —— p— -
¥ gl g
Modular Phone jack HomePortal Setup
(Y-Adapter) Wizard CD
_d' = .
G, P s
(11 e, — 2Wire PC Port

I:‘__-.—_p -, . External HomePNA Adapter
USB Cable* Phone Cord* Ethernet Cable*
(Ivory with (Light Gray) (Dark Gray)

colored ends)

*To insure the best performance, it is important to use phone
cords included in this kit.



Step

GETTING STARTED

There are a few things that you need to do before you install
your BellSouth FastAccess DSL HomeNetworking Service:

A. Verify that the computer that will be connected to the HomePortal meets
the system requirements as shown on the chart below. Information on
your system may be found by right clicking on “My Computer” and then
selecting “Properties”. If your computer does not meet these requirements,
your computer will not be compatible with FastAccess Service. Please call

1-877-263-2421 with questions or for instructions on how to return your

self-installation kit.

Minimum System Requirements:

Operating System Processor Memory |Free Disk| CD-ROM [Network Interface Monitor
Space | Space Resolution
Windows® Me™ Pentium or Equivalent 32MB 50MB Yes |Open PCl slot or USB port 800 x 600 pixels
166Mhz or faster or installed 10/100 BASE-T
Ethernet NIC and installed
dial-up modem
Windows® 2000 Pentium or Equivalent 64MB 50MB Yes |Open PCl slot or USB port 800 x 600 pixels
166Mhz or faster or installed 10/100 BASE-T
Ethernet NIC and installed
dial-up modem
Windows® 98 Pentium or Equivalent 32MB 50MB Yes |Open PCl slot or installed [800 x 600 pixels
166Mhz or faster 10/100 BASE-T Ethernet
NIC and installed dial-up
modem
Windows® 98SE Pentium or Equivalent 32MB 50MB Yes |Open PCl slot or USB port 800 x 600 pixels
166Mhz or faster or installed 10/100 BASE-T
Ethernet NIC and installed
dial-up modem
Windows NT® (Version 4.0 w/Service |Pentium or Equivalent 32MB 50MB Yes |Open PCl slot or installed [800 x 600 pixels
Pack 4 or higher) 100Mhz or faster 10/100 BASE-T Ethernet
NIC and installed dial-up
modem
Macintosh® (OS 8.6 - 9.2) Power Mac or faster 32MB 50MB Yes  |USB port or installed 10/100 [ 800 x 600 pixels

BASE-T Ethernet NIC and
installed dial-up modem

Attention Windows NT and Windows 2000 Users: HomePortal software
installation requires administrator privileges. Refer to your Windows
NT/2000 user documentation for details.

You may also access our Computer Qualification tool to test for
minimum system requirements and see if your computer is compatible
with FastAccess service. Please go to www.pcqual.com to download this
tool and test your computer.




B. You may need screwdrivers and a pair of pliers.

C. You may need the Windows operating system CD during installation. If you
do not have this CD, you will need to contact your PC vendor for details on
where the Windows files are stored.

D. You will need a telephone jack for your HomePortal phone line near your
computer. If you would like for BellSouth to install your jack, please call
your local BellSouth office to arrange for installation. (There will be a
charge for installation of a jack.)

E. Determine the HomePortal placement. The HomePortal should be placed
in a secure place near a power outlet and a telephone wall jack on your
DSL line. We also recommend that you locate the HomePortal on a desk
near a computer.

F.  Remove conflicting applications. Reinstall all applications after installation
is complete.

Applications that enable a computer to share its Internet connection
typically interfere with the HomePortal and should be uninstalled before
you install the HomePortal.

The HomePortal provides all the same features as these products — and
more — so you don't need to be concerned about losing Internet sharing
and security capabilities.

If you have any of the following (or similar) applications installed on your
computers, you should uninstall them before proceeding.

Internet sharing applications such as:

e 3Com HomecClick
¢ Microsoft Internet Connection Sharing
e Intel Anypoint ISS

Proxy software such as:

* WinGate
e Sygate
Security software such as:

e Norton
e Black Ice
e Zone Alarm



The following table will guide you through uninstalling conflicting
applications for your computer. Refer to Windows Help for instructions
on uninstalling Microsoft Internet Connection Sharing.

Macintosh*

Windows: Method 1**

Windows: Method 2**

1. Locate the CD and place in
CD-ROM drive.

2. Double-click to open the
icon that appears on your
desktop.

3. Choose Uninstall.

1. From Start, select Settings >
Control Panel.

2. Double-click on the
Add/Remove Programs icon.

3. From the list of programes,
select the networking soft-
ware and click Add/Remove.

4. Click Yes to confirm that you
want to remove the program
and all of its components.

. From Start, select Programs.

. From the list of programs,

select the networking
software.

. From the submenu, select

Uninstall.

. Click Yes to confirm that

you want to remove the
program and all of its
components.

* If you cannot locate the CD, you may need to contact your service provider or the manufacturer of the conflicting
application for instructions in uninstalling the software.

** Windows provides two methods for uninstalling software. The method you use depends on the type of software you
are uninstalling. Consult the documentation of the conflicting software for complete uninstall instructions, or use these

instructions as a guideline.

Networking Technology Overview

This kit may contain computer network adapters for the different networking
technologies described below. You will use these adapters to connect your
computers together to create your network.

A home network consists of two or more computers that have been connected
so they can “talk” to each other. A home network enables the computer users in
the household to share one Internet connection, share files without trading
diskettes, and share peripherals such as printers and external drives.

HomePortal

The 2Wire HomePortal residential gateway makes it possible to create a home
network using any of the technologies on the next page. By enabling you to
connect the computers in your home, the HomePortal provides you with all the
benefits of networking, including the ability to share one Internet connection
among all the computers and computer users in your household.

The HomePortal securely delivers rich content such as games and music
from the Internet, distributing it to multiple simultaneous users within your
household. The HomePortal is easy to install and as easy to use as browsing
the Web. The HomePortal also makes it easy to share printers, MP3 players,
Internet radios, game consoles and other Internet devices.

The HomePortal enables high-speed, Internet access to the computers on your
home network — while working to keep your private files safe from Internet
hackers. The firewall and denial-of-service attack protection built into the
HomePortal helps keep your data safe.




Percrmpree
- Ethernet

It is recommended that you use an Ethernet connection
to connect your first computer directly to the HomePortal.
Ethernet is a technology that lets you create a home
network using special wiring such as the dark gray
(Ethernet) cable included with the HomePortal. Many ERSeT
new computers are shipped with a built-in Ethernet P
adapter. You can identify an Ethernet connection jack - g
by its rectangular shape and size, which is slightly 't
larger than a standard telephone jack. Pt

eigier i | pan

= . USB

Most computers and digital devices manufactured in
the last few years come with USB connections. USB
ports, which are small and rectangular, are located
on the back of the computer. Desktop computers T I——
typically have two USB ports, and notebook
computers commonly have one. The HomePortal
has one USB port for direct connection to a

computer. USB connection is recommended if your 8 i faris 1
primary computer will be in the same room as the
HomePortal.

~ Home Phoneline Networking (HomePNA)

The HomePortal supports the HomePNA (Home Phoneline e
Networking Alliance) protocol. Home phoneline networking el s
uses HomePNA technology to let you connect computers in
different rooms using your home's existing telephone wiring.
To create a home phoneline network, you need to either
install a PCI HomePNA card into your computer or use an
. . . P mormel i
external HomePNA adapter. These devices make it possible -
> N
to connect each additional computer through the phoneline. ™, o
-
M

Home phoneline networking (HomePNA) is recommended for o
connecting additional computers to your HomePortal if those arasua i
computers are in the same room as the HomePortal, and for I
connecting computers in other rooms to the HomePortal.



Planning Your Network

The following are a few scenarios to help you plan the connections for your
first and subsequent computers:

1.Study/home office. Place your HomePortal in a visible, easily accessible
location near a power outlet, a phone jack, and a computer. If you have
multiple computers requiring Ethernet, we recommend you purchase an
Ethernet hub to connect them to the HomePortal.

2.Kitchen. Web pads or notebook computers may be your best choice in
the kitchen, because of limited counter space. We recommend using
home phoneline networking (HomePNA) to connect the computer in the
kitchen to the network.

3.Bedrooms. We recommend using home phoneline networking (HomePNA)
to connect computers in bedrooms to the network, because bedrooms
are likely to have phone jacks. This makes home phoneline networking
quite convenient.

4.Common living areas. We recommend connecting with home phoneline
networking (HomePNA), because common areas are likely to have phone
jacks.

5.Basements/attics/garages. Because of fluctuations in temperature
and humidity, the HomePortal is not recommended for use in unfinished
basements, attics, or garages.



EVERY phone jack on your FastAccess DSL line, which has a telephone or
other telephone device connected, must have filters installed. Filters reduce
interference on your telephone devices from the digital signal provided by
FastAccess service. Examples of telephone devices include:

e telephone sets e Caller ID units
e answering machines e analog modems
e fax machines e satellite television devices

If you need to order additional filters, visit fastaccess.com/consumer,
choose “Your FastAccess DSL Account”, and choose “Order Additional
Equipment”. You can continue with your FastAccess installation by
disconnecting the unfiltered telephone devices in your home until
you receive additional filters.

Filter Installation for Phones or Telephone Devices
Not Mounted on Wall

Install line filters for desktop phones and telephone devices in the order shown
below. Plug the telephone or other analog devices into the “PHONE" jack on the
filter as shown below. Once you have installed the filters, check for a dial tone
on all of your telephones.

Phone or Telephone
equipment (Phone
or Answering
Machine, Fax,
Caller ID Unit, etc.)

Phone Line Phone Line
*
Jack Filter

*There are several varieties of phone jacks.
They are usually mounted on the base-
board molding or low on the wall.

Phone Cord



Filter Installation for Wall Mounted Phones

Install the filter to the wall phone jack in the order shown below. After installing
your filter, check for a dial tone on your telephone.

&
@
Wall Mounted
Wall Mounted Phone Filter Wall Mounted
Phone Jack &) Phone



Step
INSTALL YOUR FASTACCESS INSTALLATION

WIZARD SOFTWARE CD

Turn on your computer and wait until all programs have fully loaded. Close all
applications including firewall and virus detection packages.

Insert the FastAccess Installation Wizard CD (Blue CD) and follow the on-screen
instructions and prompts to complete your installation of BellSouth FastAccess
DSL Service. When prompted for equipment type, select “2Wire".

Do not install the HomePortal until instructed by the Installation Wizard
software.

The Connection Manager is a valuable new diagnostic tool designed to
monitor, manage, and diagnose your FastAccess DSL connectivity. BellSouth
highly recommends installing this tool. An interactive Online Tutorial has
been developed to provide information and instructions on how to use the
Connection Manager. To view the tutorial, please go to fastaccesstools.com
and click on the Connection Manager Online Tutorial.
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Step

CONNECT YOUR FIRST COMPUTER

TO THE HOMEPORTAL

Choose a computer and connection type

The first computer you connect to your home network should be near your
DSL service wall jack and near the HomePortal. You will set up your home
network by connecting your first computer to the HomePortal via its Ethernet
or USB port.

Connection Type Go to page...

Choice A: Ethernet Page 11
Requires: A computer with an Ethernet port.

Recommended for: First computer in the same room as
the HomePortal.

Choice B: USB Page 12

Requires: A Windows XP, 98 SE, ME, or 2000 computer with an
. available USB port.

Recommended for: First computer in the same room as
the HomePortal.

Choice C: Network connection via Ethernet hub or switch Page 15

Requires: An Ethernet hub or switch and a computer with an
Ethernet port.

Recommended for: Multiple computers in the same room as
the HomePortal.



INSTALLING HOMEPORTAL 1000S

Choice A: Ethernet Connection
Requires a computer with an Ethernet port (not provided)

Computer
with Ethernet card
Telephone wall jack = =
with DSL -

*- 1 AC Power

HomePortal

IMPORTANT: Make sure your computer is powered off before you begin.

1.Connect the provided AC power adapter first to the POWER port on the
HomePortal. The green POWER light on the front of the HomePortal should
come on.

2.Connect the provided Ethernet cable from the LOCAL ETHERNET port on
the HomePortal to your computer’s Ethernet port.

3.Connect the provided telephone cable from the PHONE LINE port on the
HomePortal to a telephone jack with DSL service.

e If you received a Line Combiner in your installation kit, follow the
provided instructions included with the Line Combiner.

This connects the HomePortal's internal DSL modem to your FastAccess
DSL service and sets up your home network for home phoneline
(HomePNA) networking. If you have been using an external DSL
modem, you will no longer need it.

11
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Check your connections
e Power on your computer.

e After all programs have fully loaded, verify the POWER and HOME
NETWORK indicator lights on the front of the HomePortal are green.
If they are not, see “Checking Indicator Lights” on page 49. The
BROADBAND LINK indicator light will not turn green until the
HomePortal software has been installed.

Continue from here to Step 6 “Install the HomePortal Software.”

-~ Choice B: USB Connection

Requires a Windows 98 SE, Windows ME, Windows 2000, or Windows
XP computer with an open USB port

Telephone wall jack
with DSL
AC Power

Computer

HomePortal

Note: In a HomePortal network, only one Windows 98 SE, Windows ME,
Windows 2000, or Windows XP computer can be directly connected to the
HomePortal via USB. Additional computers may be added to the network
using connection options such as home phoneline networking (HomePNA).
USB/HomePortal connectivity is not available for Macintosh, Windows 95,
Windows 95 OSR2, all versions of Windows 98 (except SE), or Windows NT.

IMPORTANT: Make sure your computer is powered off before you begin.

1.Connect the provided AC power adapter first to the POWER port on the
HomePortal.



2.Connect the provided USB cable from the PC port on the HomePortal to

your computer’s USB port.

3.Connect the provided telephone cable from the LINE port on the
HomePortal to a telephone jack with DSL service.

e If you received a Line Combiner in your installation kit, follow the
provided instructions included with the Line Combiner.

This connects the HomePortal internal DSL modem to your DSL service
provider and sets up your home network for home phoneline (HomePNA)
networking. If you have been using an external DSL modem, you will no

longer need it.

Install a Windows USB driver

Before installing your HomePortal software, you must install a Windows USB
driver on your computer. The following screens may vary somewhat on
Windows ME, Windows 2000, and Windows XP.

1.Power on your computer. The Add
New Hardware Wizard opens. Click
Next to continue.

2.Select Search for best driver for
your device and click Next to
continue.

3.Place the HomePortal Setup Wizard
CD in the CD-ROM tray and select
CD-ROM drive. Click Next to
continue.

Note: Make sure only the CD-ROM drive is
selected. Otherwise Windows may load
the wrong file.
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=
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4.Select The updated driver and click
Next.

5.Click Next.

Note: If asked to insert your Windows CD,
please do so and follow the onscreen
instructions. If you don’t have your
Windows CD handy, look for the Windows
.cab files in the locations listed below:

CAWINDOWS\options\cab
C\WINDOWS
CAWINDOWS\system
C:\Win98

6.Click Finish.

7.Remove the CD from the CD-ROM
tray, then click Yes to restart your
computer.




Check your connections

¢ After all programs have fully loaded, verify the POWER and HOME
NETWORK indicator lights on the front of the HomePortal are green.
If they are not, see “Checking Indicator Lights” on page 49. The
BROADBAND LINK indicator light will not turn green until the
HomePortal software has been installed.

Continue from here to Step 6 “Install the HomePortal Software”

Choice C: Network with Ethernet Hub or Switch

Computer has Ethernet adapter and you are using an Ethernet
hub or switch

AC Power Telephone Wall Jack

(with DSL)
Additional
Computer |/ : HomePortal
First Computer - E

== \

AC Power

B Ethernet Hub g ‘1 :

Note: The HomePortal has an auto-crossover port. You do not need to use
a special crossover cable or make any changes to the configuration of your
HomePortal, Ethernet hub, or switch. The HomePortal will establish the type
of connection needed during setup.

IMPORTANT: Make sure your computer is powered off before you begin.

1.Connect the provided AC power adapter first to the POWER port on the
HomePortal. Then, and only then, connect the other end of the power
adapter’s cord to an electrical outlet. It is very important to make the
power adapter connections in this order.

2.Connect the provided Ethernet cable from the LOCAL ETHERNET port on
the HomePortal to an open port on the hub.

3.Connect the first computer’s Ethernet adapter to the hub using an
Ethernet cable.

15
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4.Connect the provided telephone cable from the PHONE LINE port on the
HomePortal to a telephone jack.

e If you received a Line Combiner in your installation kit, follow the
provided instructions included with the Line Combiner.

5.Using an Ethernet cable, connect any additional computers to the hub.
6.Plug the hub into an electrical outlet.

Check your connections
e Power on your computer.

e After all programs have fully loaded, verify the POWER and HOME
NETWORK indicator lights on the front of the HomePortal are green.
If they are not, see “Checking Indicator Lights” on page 49. The
BROADBAND LINK indicator light will not turn green until the
HomePortal software has been installed.

Repeat this step for each additional computer connected to the hub.
Continue from here to Step 6 “Install the HomePortal Software.”



Step
USING THE SAME TELEPHONE JACK FOR

YOUR HOMEPORTAL AND TELEPHONE

Telephone
wall jack

Y-AdaPiEV/T HomePortal

1.Insert the Y-Adapter into the telephone jack.

2.Connect the phone cable from the Y-Adapter to the HomePortal's
LINE port.

3.Connect the DSL Phoneline filter from the Y-Adapter to telephone cable
and connect the telephone cable to the telephone.

If you need additional filters, visit Fastaccess.com and choose
“For Home"” and then choose “Your FastAccess DSL Account”. You
can continue with your installation by disconnecting the unfiltered
telephone equipment until you receive your additional filters.

17



18

Step
INSTALL THE HOMEPORTAL SETUP WIZARD CD

ON YOUR FIRST COMPUTER

Before installing the HomePortal software, it is very important that you
note your HomePortal Key Code (525Z-25Z4-6266-22AS-B2DC) and uninstall
any conflicting applications such as firewall and file - and printer-sharing
applications. See Step 1 “Getting Started”.

Installing the HomePortal Setup Wizard on Windows PCs

1.Close all programs before
running the HomePortal
Setup Wizard.

2.Insert the HomePortal — q___""-n-....._“_y

Setup Wizard CD in the e

CD-ROM drive of your |
computer. It may take up
to one full minute for the

Setup Wizard to start. | : B
3.Follow the on-screen \ : ] -

instructions. g’“ﬂ-\

e ]

Starting the Setup Wizard -
manually on Windows PCs.

2ifiine Inelal

If, after a full minute the Setup Wizard doesn’t run automatically:
e Double-click on the My Computer icon located on the desktop.

e Double-click on the icon that corresponds to your CD-ROM drive, then
double-click Setup.exe.



1.During Step 1 of the setup, you are
given an opportunity to change the
Computer's Network name. You may
wish to change the Computer’s name
to represent its location, for example
study or bedroom. After completing
Step 1, you will be prompted to
reboot. Once rebooted, the setup
will start at Step 2.

2.During Step 2, when prompted for
the Key Code, Enter:
5257-2574-6266-22AS-B2DC.

3.When asked for your username and
password, enter your BellSouth.net
FastAccess username using this
format:
username@bellsouth.net

4. After the Setup Wizard completes,
the BROADBAND LINK indicator
light on the front of your HomePortal
will flash green as the HomePortal
establishes a connection to BellSouth
FastAccess DSL. This could take
several minutes. The light will turn
solid green when the connection
is established.
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5.Please continue setup by completing the online registration.
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Installing the HomePortal Setup Wizard on
Macintosh Computers

20

1.1f your Macintosh does not

have either the Internet
Explorer 5.5 or Netscape
4.76 Web browser, you must
install one before installing
the HomePortal software. To
install Internet Explorer 5,
drag the Internet Explorer
folder from the HomePortal
Setup Wizard CD to your
Macintosh hard drive,
double-click the Internet
Explorer icon, and, when
prompted, agree to make
Internet Explorer 5 your
default browser.

computer.

Note: Close all programs before installing the HomePortal Setup Wizard.

2¥Wrn In=uall

2.Insert the HomePortal Setup Wizard CD in the CD-ROM drive of your

3.Double-click on the 2Wire icon. A window opens with two icons. One is a

HomePortal Install icon and the other is an Internet Explorer 5 folder.
Double-click the HomePortal install icon and click Continue.

4.Click Install to copy the HomePortal software to a folder called 2Wire

HomePortal on the Macintosh hard drive. To copy the files to a different
folder, click Select Folder...from the pull-down menu and select another

folder. Click Install and follow the onscreen instructions.

5. After the Setup Wizard completes, the BROADBAND LINK indicator

light on the front of your HomePortal will flash green as the HomePortal
establishes a connection to your broadband service provider. This could
take several minutes. The light will turn solid green when the connection

is established.



Step

CONNECTING ADDITIONAL COMPUTERS

TO YOUR NETWORK

Now that your first computer is connected to the HomePortal and your
Internet connection has been established, it is time to connect your other
computers to the network. We recommend adding computers to your

network using home phoneline networking (HomePNA), because the technology
does not require new wiring throughout your home. To use home phoneline
networking to add computers to the network, you will need a HomePNA
adapter or card to connect each additional computer through the phone line.

Use the following table as a guide for connecting additional computers and/or
Internet devices to your home network.

Select ONE of the following choices for each additional computer.

Connection Type Go to page...
Choice A: HomePNA Adapters Page 22
Requires: PC Port (USB HomePNA Adapter)

Choice B: HomePNA Adapters Page 25
Requires: PCI HomePNA Adapter

Choice C: Ethernet Hub Go to Step 4,
Requires: An Ethernet hub or switch and a Choice C, of this
computer with an Ethernet port. guide.

d

If you need additional adapters, visit fastaccess.com and choose “For Home'
and then choose “Your FastAccess DSL Account”.
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CHOICE A: Installing a USB HomePNA PC Port Adapter

The PC Port adapter is an adapter that you can use to connect a computer
to the HomePortal to share Internet Access, files and printers, and using the

telephone jacks.
Installing the PC Port adapter on a Windows PC
1.Turn your computer off.

2.Insert the PC Port adapter into an available
USB port on your computer.

3.Connect one end of the supplied telephone
cable to the PC Port adapter and the other

end of the telephone cable to an available = .
wall jack. _ Cal
Note: You may have more than one phone line e

in your home. Your networked computers and
devices must be connected to the same phone line
in order to be on the same network.

Installing the Drivers For Windows

Note: The following screens show network driver installation on a computer
running Microsoft Windows ME. Screens for computer running other Windows

versions may appear in a different order and may have a slightly different
appearance.

1.Power on your computer.

2.When the Add New Hardware Wizard e P i
window opens, select Specify the P ey
location of the driver (Advanced), = e e et T T
and click Next. 2 2 Bt
- B PR

= ity S g o o o el

[ e | [ |
3.Insert the HomePortal Setup Wizard -
CD into your CD-ROM drive. Select o el
Removable Media (Floppy, CD-ROM...), £ e e gmdans]

and click Next. B R e g IS |
bl = PR S
' 2l iy
T o b ol il e ey e b W
T 1

e T |




4. Windows is now ready to load the

network drivers. Click Next. =
Pt 5L Eza
el 1 P el T A B e TR R
rﬂl‘h_lhmﬂ.'ﬂ-_
1 e e v
o] MBS
TN i PR
5.After the drivers are copied, click A
Finish. s
i ien
== |
6.When the System Settings Change
window opens, click Yes to reboot Q ikl s L
your computer to complete the P bt e
installation. If the System Settings ] = |
Change window does not open,
restart your computer. From the
Start menu, select Shut Down,
select Restart, and click OK.
Installing the PC Port adapter on a Macintosh Computer
1.Turn your computer off. | -
2.Insert the PC Port adapter into an available USB |
port on your computer. You can use any USB |
port except the keyboard port on the iMac. >
3.Connect one end of the supplied telephone LR =
cable to the PC Port adapter and the other N
end of the telephone cable to an available =
wall jGCk. P Bt

Installing the Drivers For Mac OS

Errvery pepdwd o 108 devion = Siew W Pesi”
gre e puwlavip wpaeveg bbr s inegier dee
1.Power on your computer. Sriery e Gha lrbemei!
2.Mac OS recognizes the PC Port and asks

if you would like to load the driver over = =]

the Internet. Click Cancel to continue.
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3.Insert the 2Wire PC Port CD.
Select the 2Wire PC Port Installer from
the CD and click Continue.

4. Accept or decline the License Agreement.
Click Accept to continue your PC Port
installation. Selecting Decline will end
your installation.

5.Select Easy Install.
Verify that Easy Install is selected in the
PC Port for Mac window. If it is not, select
it from the pull-down menu.

6.Restart your computer.
Your PC Port installation is complete.
Click Restart to load the PC
Port settings.

7.Establish your PC Port connection.
From the Apple menu, select Control
Panel, then TCP/IP. Set the Connect via
field to 2Wire PC Port and close the
window. If the Save changes window
displays, click Save to complete your
installation.

e e

1 o ey ——
Y




CHOICE B: Installing a PCI HomePNA Adapter

The Internal Phoneline Adapter allows you to build a network using standard

home telephone lines. Using the Internal Phoneline Adapter, you do not need to
install separate hardware or special cables.

Installing the Internal Phoneline Adapter

Note: To avoid static electric charges, touch an unpainted screw on the
outside of the power supply before installing or working with the adapter.

1.Turn your computer off and unplug the power cord.

2.Remove the outer cover of your computer and locate an available
PCl slot.

3.Remove the backplate (the small
piece of metal that covers the
opening for the PCl card on the
back cover that you just removed).

4.Insert the PCl adapter into the
PCl slot.

5.Secure the adapter with the screw _ ~ 1 J'I::"T.: =
from the backplate and replace the | R— o
cover of your computer. )

6.Use the supplied telephone cable to
connect the adapter to a telephone wall jack.

Installing Drivers For Windows 98

Note: The following screens show network driver installation on a computer
running Microsoft Windows ME. Screens for computers running other Windows

versions may appear in a different order and may have a slightly
different appearance.

1.Power on your computer. After Windows loads, the Add New Hardware
Wizard will open.

Click Next to continue.

LT T L]

Dok [ ) " Hioes, Foammpms,
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2.When prompted, select Search for
a better driver for your device
(Recommended), and click Next.

3.Insert the HomePortal Setup Wizard
CD into your CD-ROM drive, uncheck
Floppy disk drives, select the CD-ROM
drive checkbox, and click Next.

4. After Windows locates the best
driver for your device. Click Next
to continue.

5.0nce the drivers are copied, click
Finish.




6.When the System Settings Change
window opens, click Yes to reboot

.}IJ T e e P o bR A T Cmees
your computer to complete the T o e v e o o

installation. If the System Settings o

Change window does not open,

restart your computer. From the

Start menu, select Shut Down,

select Restart, and click OK.
Installing Drivers For Windows ME/XP

1.Power on your computer. Windows ME/XP automatically installs the
drivers for the Internal Phoneline Adapter.

2.Reboot your computer.

Installing Drivers For Windows 2000

1.Power on your computer and insert the HomePortal Setup Wizard CD
into your CD-ROM drive.

2.When the Found New Hardware Wizard window opens, click Next to
continue.

3.The next window prompts you to install device drivers. Select Search for
a suitable driver for my device (recommended), and click Next.

4.When the Locate Driver Files window opens, uncheck Floppy disk drives,
select the CD-ROM checkbox, and click Next.

5.When the Driver Files Search Results window opens, click Next.

6.When the Digital Signature Not Found window opens, click Yes to copy
the driver files.

7.Click Finish to complete the installation.
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Step

INSTALL YOUR FASTACCESS
INSTALLATION WIZARD SOFTWARE CD

ON YOUR ADDITIONAL COMPUTERS

Turn on your computer and wait until all programs have fully loaded. Close all
applications including firewall and virus detection packages.

Insert the FastAccess Installation Wizard CD (Blue CD) and follow the on-screen
instructions. When prompted for equipment type, select “2Wire".

The Connection Manager is a valuable new diagnostic tool designed to
monitor, manage, and diagnose your FastAccess DSL connectivity. BellSouth
highly recommends installing this tool. An interactive Online Tutorial has
been developed to provide information and instructions on how to use the
Connection Manager. To view the tutorial, please go to fastaccesstools.com
and click on the Connection Manager Online Tutorial.



Step
INSTALL THE HOMEPORTAL SETUP WIZARD CD

ON YOUR ADDITIONAL COMPUTERS

After installing your network adapter, you must configure each additional
computer to communicate with your HomeNetwork.

e Start your computer and wait until all programs have fully loaded.
¢ Place the HomePortal Setup Wizard CD in CD-ROM drive.

e Wait a full minute for CD to start up.

e Follow on-screen instructions.

e When prompted for Key Code, use the Key Code listed below:
5257-2574-6266-22AS-B2DC.

e When prompted to enter username, enter your BellSouth.net
username using this format: username@bellsouth.net

e After a reboot, if you are prompted for a Windows Network login it is
recommended that you leave the password blank and click OK.

To insure the proper configuration it is recommended that the HomePortal
setup wizard be run on all PC’s. The CD can be used to configure Windows 98,
ME, NT 4.0, Win 2000, Win XP and Macintosh 8.6 or higher.
Setting up a PC for the HomeNetwork without the CD

e Connect the computer to the HomeNetwork via Ethernet or HomePNA.

e Start your computer and wait until all programs have loaded.

 Uninstall or disable any personnel firewalls, proxy software or Internet
sharing software. (ie, Zone Alarm, Black Ice, Win Proxy). Reinstall all
applications after installation is complete.

e Configure the IP stack to obtain an IP address automatically.
e Verify the computer obtained an IP address from the Homeportal.
e Open the browser and attempt to surf the Internet.

This computer is now connected to your home network. Please repeat Steps
7, 8 & 9 for each computer you would like to connect to your home network.
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Step
INSTALL BELLSOUTH

CUSTOMIZED BROWSER

For your convenience, BellSouth offers a customized version of Microsoft
Internet Explorer. In order to take full advantage of BellSouth Internet Services
features, we recommend installing this browser. Installing this version will
update all previous versions of Internet Explorer on your computer.

If you did not install the BellSouth customized browser during the previous

step, please go to http://services.bellsouth.net/member/upgrades/ to
download the latest version.



CONGRATULATIONS!

You have completed the installation steps
for your FastAccess HomeNetworking Service.

Please review the next few pages for important information regarding Internet
security networking tools, troubleshooting tips, and file and printer sharing.

Also, for post-installation information on how to set up your e-mail account,
frequently asked questions, and other useful tips, please refer to the
Welcome Guide available online. Visit fastaccess.com and choose

“For Home” and then “Your FastAccess DSL Account”. Click on
“Self-Installation Guides”. This site will provide the latest version of

the Welcome Guide.
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MONITORED ALARM NOTICE

Attention: Customers With A Monitored Alarm
Or Emergency Response System

32

The installation of BellSouth FastAccess Internet Service may interfere
with the normal operation of a monitored alarm or emergency
response system.

1.

Immediately after you have completed the installation and testing of your
BellSouth FastAccess DSL service, you will need to test your alarm system
to ensure proper operation.

Your computer must be on and connected to FastAccess DSL service
throughout the test.

Contact your alarm or emergency response monitoring company and
explain that you have installed DSL service at your home and would like
to test your alarm system.

The monitoring company will provide you with specific instructions
to complete this test.

During the test you may lose Internet connection or sync. This interruption
of service is normal and should be only temporary.

When the test is completed, your monitoring company will be able to tell
you if the alarm operated correctly.

If your monitoring company advises you that the test was successful, your
FastAccess DSL installation is completed.

If your monitoring company advises you that the test was not successful,
please turn your Computer modem off and repeat steps 3 through 6. If the
alarm test fails in both situations, please contact your alarm company for
assistance, as the cause is not the FastAccess installation. If the alarm test
fails only when the HomePortal is on, immediately contact BellSouth
FastAccess Service at 1-800-695-6361.

Explain to the FastAccess Help Desk Representative that you have
installed FastAccess service at your home and you have discovered
through testing with your monitoring company that your alarm system
is not operating correctly.



10. The BellSouth representative will schedule a priority service appointment to
have a BellSouth installer come to your home and resolve the issue.

11. It will be necessary for you to leave your HomePortal off until the BellSouth
installer is able to resolve the issue. Unfortunately, you will not have
Internet access during the time that your HomePortal is turned off.

Note: We recommend periodic testing using the above steps, particularly

if changes have been made to your alarm/emergency response system or
FastAccess Service.
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Using HomePortal Monitor

34

HomePortal Monitor provides useful networking tools for all the computers in
your home network. It also provides information about the status of your
broadband connection.

HomePortal connection status indicators

After running the HomePortal Setup Wizard, a & icon appears in the task bar
of your computer screen.

B3¢ 2 14sam

The state of this icon indicates the status of your connection to the HomePortal
and the HomePortal's connection to the Internet.

a A red icon indicates your computer is connected to the home network
and the HomePortal is connected to the Internet.

A gray icon indicates that your HomePortal has detected a problem
with its connection to the Internet. For more information on diagnosing
your connection status go to HomePortal Help.

A gray icon with a red exclamation point down the center indicates
that your computer is not currently connected to the HomePortal. For
more information on diagnosing your connection status go to
HomePortal Help.

HomePortal Monitor tools .
o . 2WURIZ  HomePortal Monitor
Clicking on the & icon launches the

HomePortal Monitor, a handy menu of tools S Home netwerkand Intermet: Connected
such as Share Files or Printers, Current {1 coto HomePortal HOME Page..
NetWOFk, Ond Help @ Share Files and Printers...

The following information briefly describe L Refesh Computer Comecton.. _
P Current Network Primary

how to use the tools in HomePortal Monitor. %

A . . . gRenameThis Computer...
For more detailed instruction click the (2
icon to launch HomePortal help.

& Problem Notification: On
@ HomePortal Help...
@ About HomePortal Monitor

HomePortal...

| Eﬁ Exit HomePortal Monitor

Launches your home console
(http://homeportal).

<7\ Go to HomePortal Summary Page...
Launches your default Web browser and opens the HomePortal
Summary page.
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Share Files or Printers (available on Windows 98, 98 SE, and ME)...
Selects drives and printers you wish to share with other Windows 98, 98
SE, or ME computers on the network. This is a computer-specific option,
so if you want to share all drives and printers, you must use this tool on
each computer.

Refresh Computer Connection...

Re-establishes your computer’s network connection and its connection
to your HomePortal. Click this selection each time you disconnect and
reconnect a computer to your network to tell the HomePortal to
dynamically reassign an IP address to your computer.

Current Network...
Switches your computer’s network settings between two different
profiles, Primary and Alternate.

Rename This Computer...
Allows you to specify a unique computer name for each computer on
your network.

Problem Notification...

Notifies you, via pop-up window, when your computer encounters a
problem with its connection to the HomePortal of when the HomePortal
has a problem with its Internet connection.

HomePortal Help...
Launches the HomePortal Help system.

About HomePortal Monitor...
Displays the HomePortal Monitor version number and copyright
information.

Exit HomePortal Monitor...
Closes the HomePortal Monitor and allows you to specify whether
HomePortal Monitor should run when your computer is restarted.
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FILE AND PRINTER SHARING

Now that your computers are connected to each other on a network, you
can share files and network resources such as printers. To learn how, read
these sections.

1.Enable file and print sharing.
2.Set up file and print sharing.
3.Access shared files and printers.

Note: The file and printer sharing instructions in this online Help system are
for Windows 95, 98, and ME computers. For Windows NT, 2000, and Macintosh
computers, see the file and printer sharing procedures explained in the
Windows NT, 2000, and Macintosh online Help systems.

Enable File And Print Sharing

The first step to sharing files and printers is enabling sharing on your
computers.
To enable file and print sharing:
1.Click Start > Settings > Control Panel.
R WinZip
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2.Double-click the Network icon.
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3.Click the File and Print Sharing... button, then select | want to be able to
give others access to my files and | want to be able to allow others to
print to my printer(s).

4.Click OK to close the File and Print Sharing dialog box. Click OK to close
the Network dialog box.

5.1f file and printer sharing is not already installed on your computer, you
will be prompted for your Windows operating system CD.

6.When prompted, insert your Windows CD, click OK, and follow on-screen
instructions.

If you don't have your Windows CD, try the following options for locating
the needed files:

C:\WINDOWS\options\cabs
C:\Windows
C:\Windows\system
C:\Win98

Copying Files
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7.When prompted, restart your computer to allow the new settings to
take effect.

Using HomePortal Monitor To Set Up Sharing

You can use HomePortal Monitor to set up sharing of drives and printers for
Windows 95, 98, and ME computers:

1.Click the () at the bottom of your computer screen to open HomePortal
Monitor.

2.From HomePortal Monitor, select Share Files or Printers....

Note: If file sharing is not enabled, Share Files or Printers... is grayed out

in HomePortal Monitor, and you must enable file and print sharing on
your computer.

3.Select the drive or printer you wish to share. The Enter Share Name
dialog box appears.

4.Enter a name up to 12 characters or digits, including spaces. This will
be the name that appears on your home console Network page.

5.Repeat steps 3 and 4 for each drive and printer you wish to share.
6.Click OK.
To control access by using a password

1.Under the list of available drives and printers, select the Use Password
box.

2.Enter the password.
3.Click OK.

Share Files And Printers

After you have enabled file and printer sharing on your computer, you can set
up the files and printers you wish to share.

Note: The file and printer sharing instructions in this Help section are
for Windows 95, 98, and ME computers. For Windows NT, 2000, and Macintosh

computers, see the file and printer sharing procedures explained in the
Windows NT, 2000, and Macintosh online Help systems.

To share a folder

1.In Windows Explorer or My Computer, click the folder you want to share.
2.0n the File menu, click Properties.
3.Click the Sharing tab, and then click Shared As.

4.Click the Access Type you want, and, if necessary, enter a password.
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Notes

If the Sharing tab is not visible, you need to enable file and print sharing
services. See “Enable File and Print Sharing”.

You can also share disk drives by using this method.

To share a printer
1.Click Start, point to Settings, and then click Printers.
2.Click the printer you want to share.
3.0n the File menu, click Properties.
4.Click the Sharing tab, and then click Shared As.
Notes

e If the Sharing tab is not visible, you need to enable file and print sharing
services. See “Enable File and Print Sharing”.

e You can only share a printer that is connected to your computer.

e Not all printers support sharing. If you have difficulty, return to the
Printer Manufacturer Documentation.

Access Shared Files and Printers

To access shared files on another computer double-click Network Neighborhood,
and then double-click the computer where the shared folder is located.
To use a shared network printer

1.Double-click Network Neighborhood, and then locate the computer with
the printer you want to use.

2. Click the computer with the printer you want, and then click the printer icon.
3.To set up the printer, follow the instructions on the screen.
Notes

After you have set up a network printer, you can use it as if it were attached to
your computer.

To see which computers have shared printers, on the View menu, click Details,
and look for printer names or descriptions in the Comment column.
Shortcut for users of Internet Explorer

This method of accessing shared files and printers is only available when using
Internet Explorer on Windows 98 SE and ME.

1.Double-click the (&) icon on the bottom of your computer screen or open
your browser to http://homeportal to open the home console.

2.From the home console, click the Network tab.

3.Click the Access shared files... link corresponding with the computer
whose shared files or printer you wish to access.
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USING NETWORK-ENABLED GAMES

AND APPLICATIONS

40

For security reasons, the HomePortal normally blocks communication from the
Internet to “application servers” on your home network. If you need to “host” an
application server in your home, you may designate one computer in your
home as the host computer for that application, allowing data specifically
associated with that application to pass through to that computer. Only one
computer may host a particular application server at a time.

To view available hosted applications:

1.Double-click the 2Wire icon on the bottom of the computer screen or
open your browser to http://homeportal.

2.Click the Network tab and select the computer that you want to host the
application.

3.Click the Advanced... link corresponding with the computer you want to
set up as a host computer.
To assign a hosted application to a computer:

1.From the left-hand list of available hosted applications, click to select the
one you want to apply to your network computer.

2.Click Add>>, then click OK.

To remove a hosted application assignment:

1.From the right-hand list of assigned hosted applications, click to select
the one you want to remove from your network computer.

2.Click Remove>>, then click OK.



FREQUENTLY ASKED QUESTIONS

Following are frequently asked questions for networking in general, the
HomePortal, and HomePNA.

Frequently Asked Questions About Networking

How can I share files and printers between Macintosh computers?

The HomePortal does not interfere with the Macintosh method for sharing files
and printers on a network. Refer to your Macintosh online Help system for
setup and configuration.

How can | share files and printers between Windows NT machines?

The HomePortal network fully supports Windows NT and Windows 2000 file
and printer sharing. However, the HomePortal Monitor's sharing setup feature
is not currently supported for Windows NT and 2000. Instead, use the Windows
method for setting up file and printer sharing; this method is explained in
detail in the Windows online Help system.

Do | need to use a network hub or switch with my home network?

Only if you want to connect more than one Ethernet device (for example,
two computers with Ethernet cards or one computer with an Ethernet card).
You do not need to use crossover cables when connecting devices to the
HomePortal.

What kind of Ethernet cable should | use, and how should | connect it?

With HomePortal you can use any kind of Ethernet cable and connect it in
either direction. This is because the HomePortal features built-in automatic
sensing capability that detects the difference between crossover and
straight-through Ethernet cabling (RJ-45 CAT 5). You still need to be careful
with other devices connected to your hub and follow the instructions that
come with those devices.

How far apart can any two computers be in my network?

Up to 500 feet for a phoneline network, and 300 feet for an Ethernet network.

IMPORTANT: 2Wire recommends using the included light-gray telephone cables
to connect computers via phoneline and the included dark-gray Ethernet cable
to connect computers via Ethernet.
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How many computers can | attach to my home network?

You can attach as many as 253 computers or Internet devices (only 30
computers via HomePNA).

Frequently Asked Questions About HomePortal

What security features does the HomePortal provide?

The HomePortal provides some of the best security on the market by acting as
a barrier between your computer and the Internet.

The HomePortal does several key things to help protect your computer:

* As a separate piece of hardware it offers a layer of protection for a
computer owner.

¢ The HomePortal cannot run software beyond what is factory installed.
This helps to prevent a hacker from using the HomePortal to relay attacks.

e Because the HomePortal uses solid state memory and does not have
a hard drive, it can only provide limited functionality and is not open
to becoming a host to a number of Trojan horses and other hacker
applications that are used to crack systems.

e The HomePortal hides the IP addresses of the computer(s) attached to it.
This means that a port scanner scans the HomePortal open ports, not
your computers. As a first line of defense, this will help to stop you from
being marked as a potential victim by someone who is looking for an
easy target with a port scanner. It is similar to a house alarm or large
dog that will make a burglar look for another house to rob instead of yours.

e The HomePortal also blocks ports. This means that a port may be open
on your computer(s), but the open port will not be accessible from the
Internet.

e The HomePortal helps to prevent denial of service and distributed denial
of service attacks. This means that many attempts to attack your home
network by using repeated connect requests, a common technique used
by hackers, will fail.

e The HomePortal supports VPN (virtual private network) software, which
encrypts data and network addresses before sending them through the
public network and decrypts them at the receiving end.

42



How can | change my home page in my browser to the HomePortal?

Note: You can reach the HomePortal default page anytime simply by typing
homeportal in your browser’s address field.

To make HomePortal your default home page:

1.Click the "2" icon at the bottom of your computer screen to open
HomePortal Monitor.

2.From HomePortal Monitor, select Make HomePortal My Default Web Page.

Does the HomePortal work with Linux, FreeBSD, and other operating
systems?

Installation of the HomePortal software on your first computer should be done
on a computer running Windows 98, NT, 2000, XP, or Macintosh 8.5 or higher.
Also, the HomePortal Monitor portion of the graphical user interface requires
Windows 98, NT, 2000, XP, or Macintosh 8.5 or higher. Other operating systems
are not fully supported by 2Wire.

However, any computer capable of using a dynamically assigned IP address
via DHCP can be used within a HomePortal network. This means that computers
running any network-capable operating system can benefit from the security
and Internet sharing capabilities of the HomePortal. They can also point their
browsers to the HomePortal Web user interface (http://homeportal). To use the
HomePortal with an unsupported operating system:

1.0n the PC, verify that the DHCP server and the DNS (Domain Name
Server) are stopped.

2.Configure your system to run as a DHCP client.

3.Connect the computer to the HomePortal network by way of HomePNA,
or Ethernet.

Note: USB is not a supported method for adding computers with unsupported
operating systems.

Is the HomePortal software compatible with other Internet sharing
software packages out there?

No. You must disable or uninstall other Internet sharing software packages.
The HomePortal is designed to serve the Internet sharing function, and if two or
more software packages that provide Internet sharing are present, none of the
packages perform correctly. If you have inadvertently installed another Internet
sharing software package on a machine in your network, then you need to
uninstall it and re-install the HomePortal software.
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How can | uninstall the HomePortal software?

You can remove all of the HomePortal components installed on your system
with the Uninstall utility.

To uninstall HomePortal (Windows):
1.From the Start Menu, select Programs > HomePortal.
2.From the HomePortal submenu, select Uninstall HomePortal.

3.Click Yes to confirm that you want to remove the program and all of its
components.

To uninstall HomePortal (Macintosh):
1.Insert the HomePortal Setup CD.
2.Double-click the 2Wire icon on the desktop.
3.Double-click the HomePortal Install icon.
4.Click Continue.
5.From the pull-down menu select Uninstall.
6.Click Uninstall.
7.Click Continue.

Frequently Asked Questions About HomePNA

Do | need to use phoneline filters in a HomePortal-enabled HomePNA net-
work?

Yes, whether or not you are using HomePNA. Phoneline filters are required if
you have splitterless DSL and sometimes they are required even if you have
splittered DSL because splitters installed by DSL service providers do not
always completely eliminate noise on the phone line. Use phoneline filters on
each phone, answering machine, fax machine, security system, and analog
modem. You can order phoneline filters from 2Wire (2Wire DSL Filter).

Does my DSL service interfere with my HomePNA network?

No. The HomePNA network is designed to be compatible with ADSL as well as
voice band.

Can | use HomePNA and my telephone at the same time?

Yes. If you have splitterless DSL, you must use a phone-line filter on each phone
in your home.

Can | use HomePNA and the HomePortal in a digital telephone system such
as those found in many corporate environments?

No. HomePNA is designed to be used only with standard analog home tele-
phone systems.
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Will some devices interfere with my HomePNA network?

Yes, but only if you are using the older HomePNA 1.0 standard. Ham radios on
bands between 4.5 and 9 MHz, some cordless phones, power devices with a
rheostat (dimmer switch), and some older phones may affect the HomePortal
network. To diagnose such a problem, unplug all of the telephone devices in
your house, and turn off any power devices on dimmer switches and ham
radios. Then connect the HomePortal network and plug in, one at a time, each
of the telephone devices, checking the effect on your network before moving to
the next device. Then turn on your dimmer switch and ham radio, and check
the result on the HomePortal network connection. 2Wire recommends using
only HomePNA devices that support the HomePNA 2.0 standard.
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FASTACCESS TROUBLESHOOTING

Problems With Connection

If you are experiencing problems with your FastAccess DSL connection, please
use the Connection Manager to troubleshoot. If you continue to experience
problems, you can also try the recommendations listed below.

BellSouth FastAccess Support Site — Please visit www.support.fastaccess.com
for all of your troubleshooting needs. BellSouth has developed a new,
convenient site for you to get answers to commonly asked questions and
view step-by-step instructions for resolving your technical problems. In
addition, you will also find automated solutions that will solve many of your
issues with just a couple of clicks. Please visit this site for any support or
troubleshooting questions, as we will continue to add enhancements to
maximize your FastAccess online experience.

If you continue to have problems, please contact the FastAccess Help Desk at

1-888-263-2421.

e FastAccess connection
drops when phone rings
oris in use

Symptom: Try and Check:

¢ Noisy FastAccess DSL e Ensure filters are installed on all phone jacks with analog
phone line devices (See Install Filters section of this guide).

e Static on FastAccess DSL ¢ Unplug individual phones or other telephone devices to see if
phone line problem is resolved. If problem is resolved and you have a filter

attached to the unplugged device, the telephone device may
be the cause of the problem.

e Experience intermittent
loss of connection

¢ If you have a 900 MHz phone or greater near your computer,
try moving the phone away to see if the problem is resolved.

e If you have a Burglar Alarm or an Emergency Response System,
please refer to the “Monitored Alarm Notice” in this guide.

e FastAccess DSL
connection does not work
(cannot connect to the
internet)

¢ Check the HomePortal status icon on the task bar on your desktop.
e Check all connections.

— Ensure you plug the phone line connected to your DSL
HomePortal directly into the phone jack or into the side of the
filter labeled ADSL HPN.

— Ensure filters are installed on all phone jacks with telephone
devices (See Install Filters section of this guide).

— Do not plug your DSL HomePortal into a surge protector. This
may cause signal issues that will prohibit FastAccess service
from working.

e Completely shut down your computer.

¢ Remove phone line from HomePortal.

¢ Wait two minutes.

¢ Plug phone line back into HomePortal and power up the computer.




Symptom: Try and Check:
¢ No dial tone e Make sure your telephone line is connected.

e Ensure filters are installed properly on the FastAccess DSL line
for all telephone devices (See Install Filters section of this guide).

e This is a telephone line problem. Please call 611.

¢ Slow response e Clear the cache on your browser (clear Temporary Internet
files). **
* Reboot your Computer and HomePortal.t
e Cannot send/ e From your desktop, double-click the Outlook Express icon. Click
retrieve email Tools and then click Accounts. Click Add and then click Mail.

Follow the instructions on the screen.

**To clear your cache, you must open Windows Explorer, and then open your
temporary Internet files folder. You should see a cache folder here. Empty all
of its contents.

tTo Re-Boot (without shutting off power to the computer): From the Start
menu select Shutdown. Choose the Restart the Computer option and click
Yes. This procedure should be followed after making system changes, when
applications are not responding, or after completing an installation.

To Shutdown: From the Start menu select Shutdown. Choose the Shutdown
the Computer option and click Yes. This procedure shuts off all power to the
computer, and should be used only when the computer does not respond to
an attempt to re-boot.

To perform a Power Cycle: Press the Power-On/Power-Off button: this will
power-off your computer. After waiting approximately two minutes, press the
Power-On/Power-Off button again to power-on the computer and restart.
Follow this procedure when the computer fails to respond at all.
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TROUBLESHOOTING HOMEPORTAL
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This chapter describes some problems you may encounter with your
HomePortal network, and it provides suggestions for solving these problems. In
most cases, you'll be able to diagnose and solve these problems quickly and
easily, following the suggestions provided.

If you're having a problem with your HomePortal network, please check this
chapter first to see if the problem is included here. Then check 2Wire's online
Troubleshooting system before contacting the BellSouth Customer Care Center.
If the problem youre having is not covered here or online or if the suggestions
provided do not solve the problem, then please don't hesitate to contact us.

Troubleshooting Installation

I'm not sure whether my computer has a network adapter that can work
with the HomePortal.
To check Windows 95, Windows 98, and Windows ME:

1.0n your desktop, right-click My Computer.

2.Select Properties, then click the Device Manager tab.

3.Double-click Network adapters and verify that Ethernet or HomePNA
is listed.

4.If one of these adapters is not listed, install or reinstall an adapter on this
computer.

Consult the manufacturer’'s documentation for installation instructions.

To check Windows NT 4.0 and Windows 2000:
1.Right-click Network Neighborhood.
2.Select Properties.

3.Select the Adapters tab and verify that Ethernet or HomePNA
is listed.

4.1f one of these adapters is not listed, install or reinstall an adapter on this
computer.

Consult the manufacturer’'s documentation for installation instructions.



To check Macintosh OS 8.5 or higher:
1.0n your desktop, double-click your Hard Drive icon.

2.Select System Folder > Extension Folder and verify that Ethernet or
HomePNA is listed.

3.If one of these adapters is not listed, install or reinstall an adapter on
this computer.

Consult the manufacturer’'s documentation for installation instructions.

Checking Indicator Lights

The HomePortal has three indicator lights you can use to diagnose installation
and connection problems.

Power light
If the Power indicator light is not lit the HomePortal is not getting power:

e Check to see if the power cable is plugged into the power outlet or
power strip.

e Check to see if the power strip is turned on.
e Check to see if the power cord is plugged into the HomePortal.

The power cord is keyed and can only go in one way. You should feel a click
when you plug it in.

Note: If the Power indicator light is red, there is a system error, and you should
contact BellSouth Customer Care.

Broadband link light

If the Broadband Link indicator light is off, there is no physical connection to
broadband link.

e Verify that a regular telephone cord is plugged into the Line port on the
HomePortal and into the telephone outlet in the wall.

e Verify that the included light-gray telephone cable is connected from the
HomePortal DSL port to your DSL service wall jack.

Note: The DSL service wall jack is a special jack set up during installation of
DSL service. One way to verify that this is the right telephone line is to attach a
telephone to the wall jack and then listen for a dial tone. If you do not hear a
dial tone through the handset, this is probably the right telephone line to
connect to the HomePortal DSL port.

If the Broadband Link indicator light is red, the HomePortal has not been able
to establish a physical connection to your broadband link:

e Restart the HomePortal by disconnecting and re-connecting the power
cord. This will restart the HomePortal search for your broadband link.
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If the Broadband Link indicator light is solid orange, the HomePortal has
established a physical connection to your broadband link, but has not been
able to connect to your broadband services:

* Verify that DSL services are activated.

e Your computer may have applications installed that conflict with
the HomePortal. Before you can use the HomePortal to share your
broadband connection, you must remove any conflicting applications.
See “Remove conflicting applications” on page 3.

e If you changed your user name and password through your ISP, you
need to change them on the HomePortal, too. Open your browser to
http://homeportal/setup and enter your new user name and password.

Home Network light

If your networked computers are powered on and the Home Network indicator
light is not lit, the HomePortal may not be connected to any computer or hub
by way of Ethernet, USB or HomePNA. The HomePortal must be connected to
your home network in one of these ways:

e Ethernet: Verify that the Ethernet (dark-gray) cable is connected from the
HomePortal LOCAL ETHERNET port (4th plug from bottom) into the
Ethernet card in the computer or into an Ethernet hub. The Ethernet port
on the computer looks like a regular telephone jack, but bigger. If you are
using an Ethernet hub, verify the hub is plugged into a power outlet.

e USB: Verify that the ivory-colored USB cable is plugged into the computer
and the HomePortal PC port (2nd plug from bottom).

e HPNA: Verify that a regular telephone cord is connected to your HPNA
card or adapter and into a telephone outlet. Also verify that the second
included light-gray telephone cord is connected to the HomePortal Line
port and into a telephone outlet.

I'm having trouble installing the HomePortal software on Windows NT or
Windows 2000.
Verify that you have administrator user privileges. You must have administrative
user privileges to install the HomePortal software on Windows NT.
| can't connect my computer to the HomePortal.

1.Make sure the computer has an adapter installed.
On Windows 95, 98, and ME:

— On your desktop, right-click My Computer.

— Select Properties, then click the Device Manager tab.

— Double-click Network adapters and verify that an Ethernet or HomePNA
is listed.

— If the adapter is not listed, reinstall the adapter on this computer.
Consult the manufacturer’s documentation for installation instructions.
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— If more than one adapter in listed, you may need to disable the adapters
that are not being used for your HomePortal network. This is especially
true if you are using a Windows 98 computer to connect via USB. To
disable an inactive adapter, double-click the adapter, select Disable,
and click OK. Repeat for each unused adapter.

Note: A disabled adapter is unavailable. Therefore, if you use the adapter on
another network (such as work), do not disable it. Instead, use the adapter
rather than USB to connect your computer to the HomePortal network.

On Windows NT 4.0:
— Right-click Network Neighborhood.
— Select Properties.
— Select the Adapters tab and verify that an Ethernet or HomePNA is listed.

— If the adapter is not listed, reinstall the adapter on this computer.
Consult the manufacturer’s documentation for installation instructions.

— If more than one adapter in listed, you may need to disable the adapters
that are not being used for your HomePortal network. To do this, click
the Bindings tab. From the Show Bindings for pull-down menu, select all
adapters. Then select your unused adapter(s) and click Disable.

On Windows 2000:
— On your desktop, right-click My Computer.

— Select Properties, click the Hardware tab, and click the Device
Manager tab.

— Double-click Network adapters and verify that an Ethernet or
HomePNA is listed.

— If the adapter is not listed, reinstall the adapter on this computer.
Consult the manufacturer’s documentation for installation instructions.

— If more than one adapter in listed, you may need to disable the adapters
that are not being used for your HomePortal network. To do this, double-
click the unused adapter, from the Device Usage pull-down menu on the
General tab select Do not use this device (disable) and click OK. Check
the Home Network indicator light.

On Macintosh OS 8.5 or higher:
1.0n your desktop, double-click your Hard Drive icon.

— Select System Folder>Extension Folder and verify that an Ethernet
or HomePNA is listed.

— If the adapter is not listed, reinstall the adapter on this computer.
Consult the manufacturer’s documentation for installation instructions.

2.Check the Home Network indicator light.
— If it is not on, check the adapter’'s power supply, if one is used.
- If it is on, make sure the adapter is connected to the computer properly.



— If the adapter is not listed, reinstall the adapter on this computer.
Consult the manufacturer’s documentation for installation instructions.

3.Check the adapter’s power supply, if it requires a power supply.
— Make sure the outlet has power.

— Make sure the AC adapter is plugged in.

— Unplug the adapter and plug it in again.

— If you have another adapter power cable, try it with the adapter that
is causing problems.

4.If you have changed the way your computer connects to your network
(for example, from Ethernet to HomePNA), you should first uninstall and
then reinstall the HomePortal software on your computer.

If you have further problems, consult the Troubleshooting section in the user
guide that came with your adapter.

Troubleshooting Internet Connection

I got connected once successfully but am now having problems.
From HomePortal Monitor, select Refresh Home Network Connection.

| can't connect to the Internet.

Following are some tips to help you diagnose and remedy common Internet
connection problems:

1.Make sure the HomePortal is on and that the indicator lights are green.
See “Checking indicator lights” on page 56.

2.If everything seems ok, but you still cannot connect to the Internet,
close any open applications on the computer, and restart it. When
the computer has finished restarting, try connecting again.

3.Click the (2) at the bottom of your computer screen to open HomePortal
Monitor. From HomePortal Monitor, select Refresh Home Network
Connection.

4. Note to laptop users: You may need to switch back to your home settings.
From HomePortal Monitor, select Change Mobile Computer Location and
change to your home settings.
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SETTING UP YOUR BACK-UP
DIAL CONNECTION

Back-Up Internet Dial-Up Account

Your FastAccess DSL Service includes a back-up BellSouth Internet Service
dial-up account. You can use this account while you are traveling or in the
event that your FastAccess service is temporarily interrupted. To utilize your
back-up dial account, you will need to connect your telephone line to your
dial-up modem (not your HomePortal).

The back-up dial account provides for 20 hours of usage per month at no
additional cost to you. (You will, however, be responsible for any long distance
or roaming charges that may be incurred for all back-up dial usage.) In the
event you use your back-up dial-up account for more than 20 hours in any
month, you will be charged:

e Two dollars for the first hour or a fraction thereof in excess of 20 hours.

e One dollar per hour for each additional hour or fraction thereof in excess
of 21 hours.

e The total charge for the back-up dial-up account will not exceed $19.95
per month.

When you installed your FastAccess service, your back-up dial account
should have been established and a back-up dial BellSouth.net icon should
have been placed on your desktop. If this did not occur, please see the
following instructions for the operating system that you currently use.
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Windows XP Dial-Up
Networking Procedures

Dial-Up Networking can be located by selecting Start > Control Panel >
Network and Internet Connections > Network Connections.

To launch your FastAccess Dial-up Connection using Windows XP, follow
the instructions below.

1. In the Network Connections window under Network Tasks, click Create a
New Connection.
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3. Highlight Connect to the Internet and click Next.
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4. Highlight Set up my connection manually and click Next.
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5. Highlight Connect using a dial-up modem and click Next.
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6. Select Modem and click Next.
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7. Type in Bellsouth.net and click Next.
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8. Enter in the appropriate number, and click Next.

Note: See the table in the Connection Information section of this guide to find
the Dial-Up phone number for your area.

Phona Musbsr o Disl
‘wibal o g |5 s ruandsed

e this phorss rammbess bskea

[Proores raanbed
acaq et |

i gl reeed 12 ks &'11" O Bee e oinde o bty B e ges i e
you resad e safie rambeet, dial e pherss raenbsd on s isisphors. |yl
i & Wiy el b el dRiedd i i

[opsse || pma: | [ Cow |

Note: The phone number shown above is an example only and should not be
used as actual data.
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M 9. Enter the customer’s user name (using the format username@bellsouth.net)
and Password, uncheck Make this the default connection and Turn on
Internet Connection Firewall, and click Next.
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10. Click Finish.
Note: Check the box to add a shortcut to your desktop, if desired.
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11. The Connect to BellSouth.net window will appear. Click Properties.

Note: If this window does not appear, then it can be found at Start >
Control Panel > Network and Internet Connections > Network Connections
and then click BellSouth.net.
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12. Click the Networking tab.
13. Highlight Internet Protocol (TCP/IP), and then click Properties.
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14. Select Obtain an IP address automatically and select Obtain DNS
server address automatically.

15. Click Advanced.
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16. Check Use the default gateway on remote network and Use IP header
compression, and then click OK.
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17. Click OK.
18. Click OK.



19. Enter the customer’s user name (using the format username@bellsouth.net)
and Password, and click Dial.
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Note: The phone number shown above is an example only and should not be
used as actual data. See the table in the Connection Information section of this
guide to find the Dial-up phone number for your area.

20. Attempt to browse.

Creating a Shortcut to
Your Back-Up Dial Account

Windows XP

1. Click the Start button, point to Control Panel > Network and Internet
Connections, and then click on Network Connections.

2. Right-click and drag the BellSouth.net icon to your desktop and release the
mouse button.

3. Click Create Shortcut(s) Here.
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Windows® Me™ Dial-Up
Networking Procedures

Dial-Up Networking can be located by selecting Start > Settings > Dial-Up
Networking.

1. In the Dial-Up Networking window, double-click Make New Connection.

£ Dial-Up Networking
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2. Name the new entry BellSouth.net, and click Next.
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3. Enter the appropriate number, and click Next.

Note: See the table in the Connection Information section of this guide to find
the Dial-Up phone number for your area.
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Note: The phone number shown above is an example only and should not be
used as actual data.

4. Click Finish to save.

M ake New Connection x|

ou have succezsfully created a new Dial-Up Mebworking
conhection called:

B ellzouth.nel
Click Finizh ta save it in pour Dial-Up Metworking folder.
Double-click it o connect.

To edit thiz connection later, click it, click the File menu
and then chck Properties.
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5. Return to the Dial-Up Networking window and right-click the BellSouth.net
icon. Click Properties.
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6. Click on Networking tab.
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7. Select the Enable software compression and TCP/IP check boxes. The other
choices should not be selected.
8. Click TCP/IP Settings.
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9. Select Server assigned IP address and select Server assigned name
server addresses. Select the Use IP header compression and Use default
gateway on remote network check boxes.
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12. Return to the Dial-up Networking window and double-click on the
BellSouth.net icon.

13. Enter the customer’s user name (using the format username@bellsouth.net)
and Password, and click Connect.
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Note: The phone number shown above is an example only and should not
be used as actual data. See the table in the Connection Information
section of this guide to find the Dial-up phone number for your area.

14. Attempt to browse.

65



nZ wE0UZ-—-=

66

N

w

Creating a Shortcut to
Your Back-Up Dial Account

Windows Me
1.

Click the Start button, point to Settings, and then click Dial-up
Networking.

Right-click and drag the BellSouth.net icon to your desktop and release the
mouse button.

Click Create Shortcut(s) Here.



Windows® 2000 Dial-Up Networking
Procedures
To launch your FastAccess Dial-Up connection using Windows 2000, follow the
instructions below:

1. Open Network and Dial-Up Connections by selecting Start > Settings >
Network and Dial-Up Connections.

s

2. Double-click on Make a New Connection icon to open the connection
Wizard.
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3. Click Next.
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5. Select | want to set up my Internet connection manually, or | want to
connect through a local area network (LAN). Then click Next.
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6. Select | connect through a phone line and a modem. Then click Next.
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7. If the following screen appears, select your analog modem from the
drop-down menu. Click Next.

®

Enter the area code and telephone number for the local Dial-Up
connection. Then click Next.

cocon wsSQuZ—-=

Note: The phone number shown is an example only and should not be used
as actual data. See the table in the Connection Information section of this
guide to find the Dial-Up telephone number for your area.
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enter your password. Then click Next.
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10. Name the new entry BellSouth.net and click Next.
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Enter your user name (using the format username@bellsouth.net) and

Faw el
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11. You will be asked if you want to set up an e-mail account. Select No and
click Next. By leaving the check in the box in the final screen and then
clicking Finish, you will automatically connect to the Internet via Dial-Up.
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Creating a Shortcut to
Your Back-Up Dial Account

Windows 2000
1. Right-click on My Network Places on your desktop and choose Properties.

2. Right-click and drag the BellSouth.net icon to your desktop and release the
mouse button.

3. Click Create Shortcut(s) Here



Windows® 98 Dial-Up
Networking Procedures

To launch your FastAccess Dial-Up connection using Windows 98, follow the
instructions below:

1. Double-click the My Computer icon.
2. In the My Computer window, double-click Dial-Up Networking.

E My Computer

& = &

3% Floppy [A:) Mse-dos_ B [C:] D)

Control Panel Printers

3.
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4. Name the new entry BellSouth.net, and click Next.

NMake Mew Connection

5. Enter the appropriate telephone number, and click Next.

Note: The phone number shown is an example only and should not be used
as actual data. See the table in the Connection Information section of
this guide to find the Dial-Up telephone number for your area.
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6. Click Finish to save.

Make New Lopmecthon

7. Return to the Dial-Up Networking window and right-click the BellSouth.net
icon. Click Properties.

8. Click the Server Types tab.
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9. Select the Enable software compression and TCP/IP check boxes. The other
choices should not be selected.

10. Click TCP/IP Settings.
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11. Select Server assigned IP address and Server assigned name server
addresses. Select the Use IP header compression and Use default
gateway on remote network check boxes.
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12. Click OK.
13. Click OK.
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14. In the Dial-Up Networking window, to connect, double-click the
BellSouth.net icon.
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15. Enter your user name (using the format username@bellsouth.net)
and enter your Password. Click Connect.

Note: The phone number shown is an example only and should not be used
as actual data. See the table in the Connection Information section of
this guide.

=2 Connect To | 2] |

é?' BellSouth. net

@

[}

|=er name: Iusername@hellsuuth.net

Pazsword: I*"*

[ Save password

Phone number; I'I 200 2469762

Diialing framm: INew Location j Dial F'ru:uperties...l

Connect I Cancel |
x5

16. Begin browsing.
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Creating a Shortcut to
Your Back-Up Dial Account

Windows 98

1. Click the Start button, point to Programs > Accessories >
Communications > Dial-up Networking.

2. Right-click and drag the BellSouth.net icon to your desktop and release the
mouse button.

3. Click Create Shortcut(s) Here.
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78



Windows® NT Dial-Up Networking
Procedures

To launch your FastAccess connection using Dial-Up Windows® NT, follow the
instructions below:

1. Double-click My Computer.
2. In the My Computer window, double-click Dial-Up Networking.

3. In the Phonebook entry to dial section, click New.
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5. Select the | am calling the Internet check box, and click Next.

6. Enter the appropriate number, and click Next.

Note: The phone number shown is an example only and should not be used
as actual data. See the table in the Connection Information section of
this guide to find the Dial-Up phone number for your area.
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7. Click Finish to save.

MHow Phonshook Enbiy

8. In the Dial-Up Networking box, click the More menu and select Edit entry
and modem properties.
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9. Click the Server tab. Select the TCP/IP and Enable software compression
check boxes. The other choices should be left blank. Click TCP/IP Settings.
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10. Select Server assigned IP address and Server assigned name server
addresses. Select the Use IP header compression and Use default
gateway on remote network check boxes.
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11. Click OK.
12. In the Edit Phonebook Entry screen, click OK.
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13. In the Dial-Up Networking screen, click Dial to connect.

- Dial-Up Metsoakng

14. Enter your user name (using the format username@bellsouth.net) and
enter your password. Click OK.

Connect to BellSouth_net |

Enter a uger name and password with access to the
remote netwark, domairn,

zer name: Iusemame@bellsuuth.net

Pazzword: I’“‘"

Daomair: I

[~ Save password

ak [ I Cancel
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15. Begin browsing.
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Creating a Shortcut to
Your Back-Up Dial Account

Windows NT

1.

-Z ws0uz-=
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Click the Start button, point to Programs > Accessories > Dial-up
Networking.

Click the More button and select Create shortcut to entry.

Choose to look in the desktop and click OK.



Macintosh® Dial-Up Networking Procedures

To launch your BellSouth FastAccess Internet Service connection using
Macintosh® Dial-Up Networking, follow the steps below:

1. To open the TCP/IP configuration utility, click the Apple in the upper left
corner of the screen, select Control Panels, and then click TCP/IP.

2. To create a new FastAccess DSL TCP/IP configuration, click the File menu
and select Configurations.

3. Highlight a configuration and click Duplicate. In the prompt that appears,
give the profile an appropriate name (e.g. FastAccess DSL).

4. Select Make Active to make this the active configuration.

5. In the Connect Via field, select PPP from the drop-down menu. In the
Configure field, select Using PPP Server. Close the window and choose
Save when prompted.

6. To open the modem configuration utility, click the Apple in the upper left
corner of the screen, select Control Panels, and then click Modem.

7. To create a new configuration for your FastAccess DSL modem, click the
File menu and select Configurations.

8. Highlight a configuration and click Duplicate. In the prompt that appears,
give the profile an appropriate name (e.g. FastAccess DSL).

9. Select Make Active to make this the active configuration.

10. In the Connect Via field, select Alcatel SpeedTouch USB from the
drop-down menu. In the Modem field, select Null Modem 115200 from
the drop-down menu. Close the window and click Save when prompted.

11. To enter remote access settings for your FastAccess DSL connection, click
the Apple in the upper left corner of the screen, select Control Panels,
and then click Remote Access.

12. To create a new configuration, click the File menu and select Configurations.

13. Highlight a configuration and choose Duplicate. In the prompt that
appears, give the profile an appropriate name (e.g. FastAccess DSL).

14. Enter your FastAccess user name (using the format username@bellsouth.net)
and password in the respective fields, and enter a digit (e.g. 0) in the
Number field.

15. Click the Connect button to launch your FastAccess DSL connection.
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Macintosh® Dial-Up Configuration

To launch your BellSouth dial-up connection using Macintosh® Dial-Up
Networking, follow the steps below:

1.

10.

11.

12.
13.

14.

To open the TCP/IP configuration utility, click the Apple in the upper left
corner of the screen, select Control Panels, and then click TCP/IP.

To create a new dial-up TCP/IP configuration, click the File menu and select
Configurations.

Highlight a configuration and click Duplicate. In the prompt that appears,
give the profile an appropriate name (e.g. BellSouth.net).

Select Make Active to make this the active configuration.

In the Connect Via field, select PPP from the drop-down menu. In the
Configure field, select Using PPP Server. Close the window and choose
Save when prompted.

To open the modem configuration utility, click the Apple in the upper left
corner of the screen, select Control Panels, and then click Modem.

To create a new configuration for your modem, click the File menu and
select Configurations.

Highlight a configuration and click Duplicate. In the prompt that appears,
give the profile an appropriate name (e.g. BellSouth.net).

Select Make Active to make this the active configuration.

In the Connect Via field, select Internal Modem (or the dial-up modem of
your choice) from the drop-down menu. In the Modem drop down menu,
select the modem you want to connect with. Close the window and click
Save when prompted.

To enter remote access settings for your BellSouth.net dial-up connection,
click the Apple in the upper left corner of the screen, select Control Panels,
and then click Remote Access.

To create a new configuration, click the File menu and select Configurations.
Highlight a configuration and choose Duplicate. In the prompt that
appears, give the profile an appropriate name (e.g. BellSouth.net).

Enter your FastAccess user name (using the format username@bellsouth.net)

and password in the respective fields, and enter the phone number digit in
the Number field. Note: See the table in the Connection Information section
of this guide to find the Dial-up telephone number for your area.

15. Click the Connect button to launch your BellSouth.net dial-up connection.

Note: To make your FastAccess DSL connection active again, you must go to
Apple and select Control Panels. Click on Remote Access and go the File menu
and select Configurations. Highlight the FastAccess DSL connection. Select
Make Active. Go to Apple and select Control Panel. Click Modem and go to
the File menu and select Configurations. Highlight the FastAccess DSL
connection. Select Make Active. Your FastAccess DSL connection is now the
active connection.



REGULATORY INFORMATION

Declaration of Conformity

Trade Name: 2Wire

Responsible Party: 2Wire, Inc.

Address: 1704 Automation Pkwy.
San Jose, CA 95131

Telephone Number: 408-428-9500

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This device
may not cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to
Part 15 of the Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following measures:

¢ Reorient or relocate the receiving antenna.

¢ Increase the separation between the equipment and the receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
e Consult the dealer or an experienced radio/TV technician for help.

You are cautioned that any changes or modifications not expressly approved in this manual could void your
authority to operate this equipment.

Only peripherals (computer input/output devices, terminals, printers, and so forth) that comply with FCC Class B
limits may be attached to this computer product.

Operation with noncompliant peripherals is likely to result in interference to radio and television reception.

All cables used to connect peripherals must be shielded and grounded. Operation with cables, connected to
peripherals, that are not shielded and grounded may result in interference to radio and television reception.

CAUTION: To comply with FCC RF exposure requirements, a separation distance of at least 8 inches (20 cm) must
be maintained between the antenna of this and all persons.

FCC Part 68

This equipment complies with Part 68 of the FCC rules. On the bottom of this equipment is a label that contains,
among other information, the FCC equivalence number (REN) for this equipment. If requested, this information must
be provided to the telephone company.

The REN is used to determine the quantity of devices that may be connected to the telephone line. Excessive RENs
on the telephone line may result in the devices not ringing in response to an incoming call. In most, but not all
areas, the sum of the RENs should not exceed five. To be certain of the number of devices that may be connected
to the line, as determined by the total RENs, contact the telephone company to determine the maximum REN for
the calling area.

If the terminal equipment causes harm to the telephone network, the telephone company will notify you in advance
that temporary discontinuance of service may be required. But if advance notice is not practical, the telephone
company will notify the customer as soon as possible. Also, you will be advised of your right to file a complaint with
the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that could affect
the operations of the equipment. If this happens, the telephone company will provide advance notice in order for
you to make the necessary modifications in order to maintain uninterrupted service.

If trouble is experienced with this equipment, please contact the store, reseller, or agent from whom the HomePortal
was purchased.

Repair of this equipment should be made only by the 2Wire Service Center or a 2Wire authorized agent.
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LIMITED HARDWARE WARRANTY
Thank you for selecting 2Wire products. Retain your proof of purchase along with this warranty card.
Limited Hardware Warranty

2Wire warrants to the original owner that the hardware product delivered in this package will be
free from material defects and workmanship for one (1) year following the date stated on the receipt
evidencing proof of purchase of the product. The warranty does not cover the product if it is damaged in the
process of being installed.

THE ABOVE WARRANTY IS IN LIEU OF ANY OTHER WARRANTY, WHETHER EXPRESS, IMPLIED OR STATUTORY,
INCLUDING, BUT NOT LIMITED TO ANY WARRANTY OF NONINFRINGEMENT OF INTELLECTUAL PROPERTY,
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR ANY WARRANTY ARISING OUT OF ANY
PROPOSAL, SPECIFICATION, SAMPLE OR OTHERWISE.

This warranty does not cover replacement of products damaged by abuse, accidental misuse, neglect,
alteration, repair, disaster, improper installation or improper usage. If the product is found to be
otherwise defective, 2Wire, at its option, will replace or repair the product at no charge, except as set forth
below, provided that you deliver the product along with a return material authorization (RMA) number either
to the company from whom you purchased it or to 2Wire (North America only) within the one-year warranty
period, or within 5 days after expiration of the warranty period (to allow for delivery time). If you ship the
product, you must assume the risk of damage or loss in transit. You must use the original container (or
the equivalent) and pay the shipping charge. 2Wire may replace or repair the product with either new or
remanufactured product or parts, and the returned product becomes 2Wire's property. 2Wire warrants the
repaired or replaced product to be free from material defects and workmanship for a period of the greater
of: (i) ninety (90) days from the date you received the repaired or replaced product, or (ii) the period of time
remaining on the original one (1) year warranty. This warranty gives you specific legal rights, and you may
have other rights that vary from state to state. All parts or components contained in this product are covered
by 2Wire's limited warranty for this product.

Returning a Defective Product (RMA)

Before returning any product, contact 2Wire Customer Support and obtain an RMA number by calling:

US & Canada only:

1-800-877-5718 for filter and adapter products

1-877-347-8680 for residential gateway products or,

Return the product to the place of purchase. If 2Wire Customer Support determines that the product may be

defective, they will issue you an RMA number to place on the outer package of the product. 2Wire
cannot accept any product without an RMA number on the package.

Limitation of Liability and Remedies

2Wire SHALL HAVE NO LIABILITY FOR ANY INDIRECT OR SPECULATIVE DAMAGES, INCLUDING, WITHOUT
LIMITATION, CONSEQUENTIAL, INCIDENTAL AND SPECIAL DAMAGES ARISING FROM THE USE OF OR INABILITY
TO USE THIS PRODUCT, NEGLIGENCE, TORT, AND/OR BREACH OF WARRANTY, IRRESPECTIVE OF WHETHER 2Wire HAS
ADVANCE NOTICE OF THE POSSIBILITY OF ANY SUCH DAMAGES, INCLUDING, BUT NOT LIMITED TO LOSS
OF USE, INFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS, BUSINESS INTERRUPTIONS, AND LOSS OF PROFITS.
NOTWITHSTANDING THE FOREGOING, 2Wire's TOTAL LIABILITY FOR ALL CLAIMS UNDER THIS AGREEMENT
SHALL NOT EXCEED THE PRICE PAID FOR THE PRODUCT. THESE LIMITATIONS ON POTENTIAL LIABILITIES WERE
AN ESSENTIAL ELEMENT IN SETTING THE PRODUCT PRICE. 2Wire NEITHER ASSUMES NOR AUTHORIZES ANYONE TO
ASSUME FOR IT ANY OTHER LIABILITIES.

Some states do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitations or exclusions may not apply to you.

Critical Control Applications

2Wire specifically disclaims liability for use of the hardware product in critical control applications (including,
for example only, safety or health care control systems, nuclear energy control systems, or air or ground
traffic control systems) by user, and such use is entirely at user’s risk. User agrees to defend, indemnify, and
hold 2Wire harmless from and against any and all claims arising out of use of the hardware product in
such applications.

Software

Software provided with this product is not covered under the hardware warranty described above. See the
applicable software license agreement that ships with your product for details on any software
warranty. By your use of the software included with the product, you are hereby agreeing to the terms and
conditions of the License Agreement.

5100-000082-000 Rev A February 2002



LICENSE AGREEMENT
This License Agreement ("Agreement”) is made between 2Wire, Inc. ("2Wire”) and you (“Licensee”).

This Agreement includes the terms and conditions and contains, among other things, warranty disclaimers,
liability limitations and use limitations.

TERMS AND CONDITIONS

1. Grant of License and Restrictions. Subject to all the terms of this Agreement and payment of all fees for the
product, 2Wire, Inc., grants Licensee a nonsublicensable, nonexclusive, right to internally use the non-source code
form of the software solely as embedded in and for installation of the 2Wire HomePortal (the “Product”). Licensee
will maintain the copyright notice and any other notices that appear on the Product on any such copies and
any media. Licensee will not (i) reverse engineer or attempt to discover any source code or underlying ideas or
algorithms of any Product (except to the extent that applicable law prohibits reverse engineering restrictions
and then only after written notice to 2Wire); (ii) use any Product, or allow the transfer, transmission, export, or
re-export of any Product or portion thereof in violation of any export control laws or regulations administered
by the U.S. Commerce Department, OFAC, or any other government agency; or (iii) copy or modify the software
contained in the Product. All the limitations and restrictions on Products in this Agreement also apply to
documentation. 2Wire reserves all rights not expressly granted herein.

2. Support and Maintenance. For support and maintenance services for the Product during the one-year warranty
period, please call 2Wire Technical Support at the phone number listed on the warranty card.

3. Termination. This Agreement and all licenses will terminate thirty days (immediately in the case of a breach of
Section 1) after notice of any breach by Licensee remaining uncured at the end of such notice period. Upon
termination, or if a license ceases to be effective, Licensee shall immediately cease all use of all affected Products
and return or destroy all copies of all affected Products and all portions thereof and so certify to 2Wire. Sections 5,
6, and 7 and shall survive termination. Termination is not an exclusive remedy and all other remedies will be
available whether or not termination occurs. 2Wire has the right to discontinue marketing, distribution, or
licensing of the Product at any time in its sole discretion.

4. Indemnification. 2Wire shall hold Licensee harmless from liability to third parties resulting from infringement by
the software component of a Product of any United States patent or any copyright or misappropriation of any
trade secret, provided 2Wire is promptly notified of any and all threats, claims, and proceedings related thereto
and given reasonable assistance and the opportunity to assume sole control over defense and settlement; 2Wire
will not be responsible for any settlement it does not approve in writing. The foregoing obligations do not apply with
respect to the software component of a Product or portions or components thereof (i) not supplied by 2Wire; (ii)
made in whole or in part in accordance to Licensee specifications; (iii) that are modified after delivery by 2Wire; (iv)
combined with other products, processes, or materials where the alleged infringement relates to such
combination; (v) where Licensee continues allegedly infringing activity after being notified thereof or after being
informed of modifications that would have avoided the alleged infringement; (vi) where Licensees use of such
Product is not strictly in accordance with this Agreement; or (vii) that may cause infringement by the process of
caching generally. Licensee will indemnify 2Wire from all damages, settlements, attorney’s fees, and expenses
related to any claim of infringement or misappropriation excluded from 2Wire's indemnity obligation by the
preceding sentence.

5. Limited Warranty and Disclaimer. 2Wire warrants for a period of one (1) year from Licensee’s first acquisition of
the Product that the Product hardware and media containing the software will be free from material defects and
that the software component of the Product will materially conform to 2Wire's then current user documentation for
such Product. 2Wire's sole obligation, and Licensee's sole remedy, with respect to any warranties set forth herein
and made within the applicable warranty period that shall be for 2Wire, at 2Wire's sole discretion, to: (i) use
reasonable efforts to correct documented failures that 2Wire's diagnosis indicates are caused by a defect in the
unaltered, latest version of the Product to cause the Product to materially conform to 2Wire's then-published
specifications; (i) replace the Product with a Product meeting such published Product specifications; or (iii) accept
return of the Product and refund to Licensee the fees with respect to such Product. The warranties set forth herein
shall become void: (i) at the expiration of the warranty period; (i) if the Product has been modified or altered in any
way; (iii) if the defect is the result of an event after delivery to the Licensee; (iv) if Licensee is in breach of any
agreement with 2Wire; (v) if the Product has not been installed, operated, repaired or maintained in accordance
with any installation, handling, maintenance, or operating instructions supplied by 2Wire; (vi) has been subjected
to unusual physical or electrical stress, misuse, negligence, or accident; or (vii) if the Product is used in
ultra-hazardous activities. This warranty covers only problems reported to 2Wire during the warranty period in
connection with nonconforming Products returned to 2Wire in accordance with 2Wire's then current warranty
return procedures. ANY LIABILITY OF 2Wire WITH RESPECT TO A PRODUCT OR THE PERFORMANCE THEREOF UNDER ANY
WARRANTY, NEGLIGENCE, STRICT LIABILITY, OR OTHER THEORY WILL BE LIMITED EXCLUSIVELY TO PRODUCT
REPLACEMENT OR, IF REPLACEMENT IS INADEQUATE AS A REMEDY OR, IN 2Wire's OPINION, IMPRACTICAL, TO REFUND
OF THE LICENSE FEE. EXCEPT FOR THE FOREGOING, ALL PRODUCTS ARE PROVIDED “AS IS” WITHOUT WARRANTY OF ANY
KIND INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE
OR NONINFRINGEMENT. FURTHER, COMPANY DOES NOT WARRANT RESULTS OF USE OR THAT THE PRODUCTS ARE BUG
FREE OR THAT THEIR USE WILL BE UNINTERRUPTED. Some states do not allow limitations on how long an implied
warranty lasts, so the above limitations may not apply to you.

6. Limitation of Liability. NOTWITHSTANDING ANYTHING ELSE IN THIS AGREEMENT OR OTHERWISE, AND EXCEPT FOR
BODILY INJURY, THE COMPANY AND ITS LICENSORS SHALL NOT BE LIABLE OR OBLIGATED WITH RESPECT TO THE SUBJECT
MATTER OF THIS AGREEMENT OR UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR
EQUITABLE THEORY (i) FOR ANY AMOUNTS IN EXCESS IN THE AGGREGATE OF THE FEES PAID TO IT HEREUNDER WITH
RESPECT TO THE APPLICABLE PRODUCT DURING OR PRIOR TO THE CAUSE OF ACTION; OR (i) FOR ANY COST OF
PROCUREMENT OF SUBSTITUTE GOODS, TECHNOLOGY, SERVICES OR RIGHTS; (iiij FOR ANY INCIDENTAL OR
CONSEQUENTIAL DAMAGES; (iv) FOR INTERRUPTION OF USE OR LOSS OR CORRUPTION OF DATA; OR (v) FOR ANY
MATTER BEYOND ITS REASONABLE CONTROL. Some states do not allow the exclusion or limitation of incidental or
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consequential damages, so the above limitation and exclusions may not apply to you.

7. Miscellaneous. This Agreement and the licenses granted hereunder are assignable or transferable by Licensee
only in conjunction with the sale and transfer of the 2Wire Product within which the software was first delivered.
2Wire may assign this Agreement in whole or in part. Any notice, report, approval or consent required or
permitted hereunder shall be in writing. Licensee hereby represents that Licensee is not an agency, department or
other entity of the United States Government. If this license is acquired under a U.S. Government contract, use,
duplication, or disclosure by the U.S. Government is subject to restrictions set forth in FAR subparagraphs 52.227.19
(a) and (d) for civilian agency contracts and DFARS 252.227-7013@ii) for Department of Defense contracts. No
failure or delay in exercising any right hereunder will operate as a waiver thereof, nor will any partial exercise of
any right or power hereunder preclude further exercise. If any provision of this Agreement shall be adjudged by
any court of competent jurisdiction to be unenforceable or invalid, that provision shall be limited or eliminated to
the minimum extent necessary so that this Agreement shall otherwise remain in full force and effect and
enforceable. This Agreement shall be deemed to have been made in, and shall be construed pursuant to the laws
of, the State of California and the United States without regard to conflicts of laws or provisions thereof, and
without regard to the United Nations Convention on the International Sale of Goods. Any waivers or amendments
shall be effective only if made in writing. This Agreement is the complete and exclusive statement of the mutual
understanding of the parties and supersedes and cancels all previous written and oral agreements and
communications relating to the subject matter of this Agreement. The prevailing party in any action to enforce this
Agreement will be entitled to recover its attorney’s fees and costs in connection with such action. Licensee
represents that it is not a government agency and it is not acquiring the license pursuant to a government
contract or with government funds.



Connection Information

Please follow the directions below to access helpful information to be used
when configuring your e-mail account and back-up dial account, including
numbers for mail servers, news servers, and general dial-up for your location.

For the most current connection information please visit the BellSouth website:
home.bellsouth.net. Click on the Member Services tab. Click on My Account.

Click Log in Now. Type your Login ID (user name) and Password and then click
Login. Click Dial-in Sites under Cities. Click your city and then click Get Info.

Dial-up phone numbers for your location have been included for your

convenience.

Metro Dial-Up Metro Dial-Up Metro Dial-Up
Phone Number Phone Number Phone Number
ALABAMA GEORGIA MISSISSIPPI
Anniston | (256) 231-0890 Albany | (912) 430-9042 Biloxi | (228) 374-3043
Auburn | (334) 501-1398 Athens | (706) 549-2131 Hattiesburg | (601) 261-9448
Birmingham | (205) 871-5621 Atlantal| (770) 300-8900 Jackson| (601) 351-4826
Cullman | (256) 7379853 Atlanta2 | (404) 248-3900 NORTH CAROLINA
Decatur | (256) 301-0606 Augusta | (706) 849-0820 Arden | (828) 654-8224
Florence | (843) 317-1211 Brunswick | (912) 262-0970 Charlotte| (704) 331-0136
Gadsden | (256) 543-7771 Calhoun| (706) 602-7779 Gastonia | (704) 869-9606
Huntsville | (256) 864-3226 Columbus | (706) 561-4846 Greensboro | (336) 292-5168
Jasper | (205) 221-4020 Macon | (912) 752-0861 Raleigh | (919) 685-9500
Mobile | (334) 432-4398 Savannah| (912) 644-6703 Wilmington | (910) 2517676
Montgomery | (334) 833-0905 Stone Mountain | (770) 300-8900 Winston Salem | (336) 724-1160
Selma | (334) 877-4009 Valdosta | (912) 333-0490 SOUTH CAROLINA
Tuscaloosa | (205) 330-0806 Vidalia | (912) 537-1005 Anderson | (864) 222-0924
FLORIDA KENTUCKY Camden | (803) 425-4100
Boca Raton | (561) 392-2770 Bowling Green | (270) 393-2311 Charleston | (843) 720-8854
Cocoa | (321) 504-4110 Georgetown | (502) 867-5820 Columbia| (803) 252-8294
Daytona Beach | (904) 238-8881 Hopkinsville | (270) 881-9876 Florence | (843) 317-1211
Ft. Lauderdale | (954) 522-3610 Louisville | (502) 582-9225 Greenville| (864) 271-2091
Fort Pierce | (561) 462-3004 Owensboro | (270) 683-9064 Orangeburg | (803) 535-4003
Gainesville | (352) 377-5820 Paducah| (270) 4159134 Seneca| (864) 888-8003
Jacksonville | (904) 350-1090 LOUISIANA Spartanburg | (864) 577-9421
Miami | (305) 373-8280 Alexandria | (318) 427-9262 TENNESSEE
Orlando | (407) 896-7275 Baton Rouge | (225) 343-0205 Chattanooga | (423) 265-5045
Panama City | (850) 769-7667 Hammond | (504) 230-0560 Clarksville | (931) 221-0704
Pensacola | (850) 969-0044 Houma | (504) 223-0704 Jackson | (901) 265-0503
Spring Hill | (352) 683-2919 Lafayette | (318) 289-6743 Knoxville | (423) 525-6729
Stuart | (561) 219-6984 Lake Charles | (337) 474-2382 Memphis | (901) 495-1700
Vero Beach | (561) 562-1990 Monroe | (318) 322-5008 Nashville | (615) 254-8787
W. Palm Beach | (561) 835-1220 New Orleans | (504) 525-3398
Shreveport | (318) 675-2450
Slidell | (504) 641-5222




BellSouth” Internet Service Service Agreement

This is a legal agreement between you and BellSouth Telecommunications, Inc. (“BellSouth”) for the use of the BellSouth® Internet
Service online gateway (including BellSouth® FastAccess® Internet Service) and Internet access service and related features (the
“Service”). If you do not agree to the terms and conditions in this Agreement, do not register for or use the Service. By completing
the registration and using the Service, you signify your agreement with the terms and conditions of this Agreement. If you do not
agree to all of the terms and conditions of this Agreement, please return the client software and all associated materials to
BellSouth.

1. The Service.

A. GENERAL

BellSouth® Internet Service, which may be marketed as BellSouth® Internet Service or under various other BellSouth names
or marks including any Equipment and Software used in conjunction therewith, are referred to collectively herein as the
“Service”. The Service consists of Internet Protocol (“IP") connectivity to the BellSouth® Internet Service online gateway, as well
as access or connectivity to any of the information sources or services which may be provided by BellSouth or be available
from other service providers participating in or connected to BellSouth's Service. Some of these additional services may be
provided without charge to users of BellSouth's Service, but separate charges may be applicable to some of these other
services. These charges may appear on your bill from BellSouth, or they may be billed to you separately by the providers of
such services. Some other providers may also have additional registration or eligibility requirements in order to use their
services. By posting updated versions of this Agreement on the Service or otherwise providing notice to you, BellSouth may
modify the terms of this Agreement or prices for the Service, and may discontinue or revise any or all other aspects of the
Service in its sole discretion and without prior notice. All such changes shall become effective upon posting of the revised
Agreement on the Service, as to Service used by you after the date of such changes. The updated, online version of this
Agreement shall supersede any prior paper or disk-based or CD-based copies of this Agreement that may have been
included in any browser software or related materials provided by BellSouth.
FastAccess
BellSouth's high-speed Internet access service is known as BellSouth® FastAccess® Internet Service.
Service Description: BellSouth FastAccess Internet Access is a best efforts service, which can provide speeds up to 1.5 Mbps
downstream (from the BellSouth facility to the customer location) and 256Kbps upstream (from the customer location to the
BellSouth facility). The Service is a best efforts service. The actual speed experienced by customers may vary and depends
on several factors including customer location, destination on the Internet, traffic on the Internet, interference with high
frequency spectrum on the customer’s telephone line, etc. No minimum level of speed is guaranteed.

Back-Up Internet Dial-Up Account: BellSouth FastAccess DSL Service includes access to a back-up BellSouth Internet Service
dial-up account. This account is intended to be used while you are traveling or in the event that FastAccess service is
temporarily interrupted. The back-up dial account provides for 20 hours of usage per month at no additional cost to you.
(You will, however, be responsible for any long distance or roaming charges that may be incurred for all back-up dial
usage.) In the event you use your back-up dial-up account for more than 20 hours in any month, you agree to pay BellSouth
two dollars for the first hour or fraction thereof in excess of 20 hours and one dollar per hour for each additional hour or
fraction thereof in excess of 21 hours. Billing for usage over 20 hours will not exceed $19.95.

The total charge for the back-up dial account will not exceed $19.95 per month.

2. Term. This Agreement for the use of the Service will be in effect from the date your completed registration is accepted by
BellSouth. This Agreement and your use of the Service may be terminated by either you or BellSouth at any time by written
notice to the other, or by BellSouth at any time with or without notice for your non-payment or other default. The provisions
of paragraphs 4-9 and 12, and all obligations of and restrictions on you and any user of your account with respect to the
Service shall survive any termination of this Agreement.

3. Service Rates and Charges. The rates and charges for the Service shall be as set forth in your registration package or
otherwise in accordance with BellSouth’s rate schedule as in effect from time to time, a copy of which will be available online
on the Service or otherwise shall be provided to you upon request. Rates and charges, and other terms and conditions of the
Service, are subject to change by BellSouth from time to time by notice to you provided on the Service or otherwise. You will
be invoiced monthly for usage of the Service and for any other services utilized by you or other users of your account which
are billed for by BellSouth in connection with the Service (including any applicable taxes), either directly by BellSouth or
through your designated credit card company.

If you choose to have the charges for your Service added to your telephone bill, then any late payment/interest charges will
be computed in accordance with standard telephone company billing practices and procedures using those rates applicable
to tariffed local service. If you choose to pay by credit card, the terms of the applicable credit card agreement will apply and
any late payment/interest charges will be computed in accordance with your credit card agreement.

4. Other Responsibilities of User. You agree that you will be the only user of your account ID and password and that you will
not transfer or disclose either your account ID or password to any other person (except that you may at your own risk and on
your own responsibility permit other members of your family or business associates to access the Service using your account
ID and password), and that you will be responsible for all usage of the Service and any other services accessed through the
Service on your account whether or not authorized by you. You agree to pay the applicable fees as set forth in your billing
statement by the due date, and to pay any interest or late fees incurred for late payment of the required fees. You agree not
to transmit or publish on or over the Service any information, software or other content, which violates or infringes upon the
rights of any others or to use the facilities and capabilities of the Service to conduct any business or activity or solicit the
performance of any activity which is prohibited by law. You agree to comply with all applicable laws, rules and regulations in
connection with the Service. You acknowledge that you are aware that certain content, services or locations of the Service or
of other parties that may be accessible through the Service may contain material that is unsuitable for minors (persons
under 18 years of age). You agree to supervise usage of the Service by any minors whom you permit to use the Service.

5. Limitation of Warranties and Liability; Disclaimer of Warranties. YOU EXPRESSLY AGREE THAT USE OF THE SERVICE IS AT YOUR
SOLE RISK. NEITHER BELLSOUTH NOR ANY OF ITS UNDERLYING SERVICE PROVIDERS, INFORMATION PROVIDERS, LICENSORS,
EMPLOYEES, OR AGENTS WARRANT THAT THE SERVICE WILL BE UNINTERRUPTED OR ERROR FREE; NOR DOES BELLSOUTH OR ANY
OF ITS UNDERLYING SERVICE PROVIDERS, INFORMATION PROVIDERS, LICENSORS, EMPLOYEES, OR AGENTS MAKE ANY WARRANTY
AS TO THE RESULTS TO BE OBTAINED FROM USE OF THE SERVICE. THE SERVICE IS DISTRIBUTED ON AN “AS IS”, “AS AVAILABLE" BASIS
WITHOUT WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF TITLE OR
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR OTHERWISE, OTHER THAN THOSE
WARRANTIES (IF ANY) WHICH ARE IMPLIED BY AND INCAPABLE OF EXCLUSION, RESTRICTION, OR MODIFICATION UNDER THE LAWS
APPLICABLE TO THIS SERVICE AGREEMENT, ALL SUCH WARRANTIES BEING EXPRESSLY DISCLAIMED. NEITHER BELLSOUTH NOR ANY
OF ITS UNDERLYING SERVICE PROVIDERS, INFORMATION PROVIDERS, LICENSORS, EMPLOYEES, OR AGENTS SHALL HAVE ANY
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12.

LIABILITY FOR INCIDENTAL, CONSEQUENTIAL, INDIRECT OR SPECIAL DAMAGES SUFFERED BY YOU OR ANY OTHER PARTY AS A
RESULT OF THE OPERATION OR MALFUNCTION OF THE SERVICE, REGARDLESS OF WHETHER OR NOT SUCH PARTIES HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. YOU EXPRESSLY ACKNOWLEDGE THAT THE PROVISIONS OF THIS SECTION SHALL
ALSO APPLY TO ALL CONTENT OR OTHER SERVICES AVAILABLE THROUGH THE SERVICE. YOU AGREE THAT YOU WILL NOT IN ANY
WAY HOLD BELLSOUTH RESPONSIBLE FOR ANY SELECTION OR RETENTION OF, OR THE ACTS OR OMISSIONS OF, THIRD PARTIES IN
CONNECTION WITH THE SERVICE (INCLUDING THOSE WITH WHOM BELLSOUTH MAY CONTRACT TO OPERATE VARIOUS AREAS ON
THE SERVICE).

Remedies of User. Your sole and exclusive remedy for any failure or non-performance of the Service (including any associated

software or other materials supplied in connection with the Service) shall be for BellSouth to use commercially reasonable

efforts to effectuate an adjustment or repair of the Service and, in the event such downtime exceeds twenty-four consecutive
hours, to receive a pro-rata refund or credit of or against any charges otherwise payable for the Service for the period of

Service downtime.

Limitation of Liability. In the event that a court should hold that the limitations of liabilities or remedies available as set forth

in this Agreement, or any portions thereof, are unenforceable for any reason, or that any of your remedies under this

Agreement fail of their essential purpose, you expressly agree that under no circumstances shall BellSouth's total liability to

you or any party claiming by, through or under you for any cause whatsoever, and regardless of the form of action, whether

in contract or in tort, including negligence, in the aggregate, exceed the amount of charges paid by you for use of the Service
under this Agreement during the twelve-month period preceding the date such claim first arose.

Indemnification by User. You shall indemnify and hold harmless BellSouth and any of its underlying service providers,

information providers, licensors, employees or agents from and against any and all claims, demands, actions, causes of

action, suits, proceedings, losses, damages, costs, and expenses, including reasonable attorneys fees, arising from or relating
to your use of the Service, or any act, error, or omission of you or any user of your account in connection therewith, including,
but not limited to, matters relating to incorrect, incomplete, or misleading information; libel; invasion of privacy; infringement
of a copyright, trade name, trademark, service mark, or other intellectual property; any defective product or any injury or
damage to person or property caused by any products sold or otherwise distributed through or in connection with the

Service; or violation of any applicable law.

Use of Materials, Marks and Information.

a. You may use, copy and distribute the materials found on the Service for internal, noncommercial, informational services
only. All copies that you make of the material must bear any copyright, trademark or other proprietary notice, which
pertain to the material being copied. Except as authorized in this paragraph, you are not being granted a license under
any copyright, trademark, patent or other intellectual property right in the material or the products, services, processes
or technology described therein. All such rights are retained by BellSouth, its affiliates and/or any third party owner of
such rights.

. The BellSouth company names and logos and all related product and service names, design marks and slogans are the
property of BellSouth or its affiliates. You are not authorized to use any BellSouth name or mark in any advertising, publicity
or in any other commercial manner without the prior written consent of BellSouth.

. Any feedback, data, answers, questions, comments, suggestions, ideas or the like, which you send to BellSouth will be
treated as being nonconfidential and nonproprietary. BellSouth assumes no obligation to protect such information from
disclosure and will be free to reproduce, use, and distribute the information to others without restriction. BellSouth will
also be free to use any ideas, concepts, know-how or techniques contained in such information for any purpose
whatsoever including but not limited to developing, manufacturing and marketing products and services incorporating
such information. BellSouth may also use your status as a subscriber to the Service for the purpose of marketing to you
other BellSouth products and services.

Endorsements. All product and service marks contained on or associated with the Service that are not BellSouth marks are

the trademarks of their respective owners. References to any names, marks, products or services of third parties or hypertext

links to third party sites or information do not necessarily constitute or imply BellSouth's endorsement, sponsorship or
recommendation of the third party, information, product or service.

Browser Software. If any Internet browser or other software has been provided to you for use with the Service, you agree to

be bound by and to comply with the terms and conditions of the separate software license, which is applicable to and was

provided to you along with such software.

Personal Webpages. BellSouth may make personal Webpages available as an optional feature of its BellSouth® Internet

Service. If you subscribe to such feature the following provisions of this Section shall apply (in addition to the other provisions

of this Agreement):

a. BellSouth may provide a listing/link to users’ personal Webpages on its BellSouth® Internet Service gateway or other

mechanisms. By subscribing to the personal Webpage feature, you authorize and grant BellSouth the right to use your

name, Website address and similar information in such listing or directory sites or applications. You may use the complete
address (URL) granted to you as part of the personal Webpage feature (which may have names or marks of BellSouth
embedded therein) so long as you are obtaining the personal Webpage feature from BellSouth hereunder, but only for the
purpose of identifying the location of your personal Website on BellSouth's Service. Otherwise, you shall not utilize the name
or any marks of BellSouth or any of its affiliates in any press releases, promotional materials or other commercial manner
without the express prior written approval of BellSouth in each instance.

Ownership of all graphics, text or other information or content materials supplied or furnished by you for incorporation

into or delivery through your personal Website shall remain with you (or the party which supplied such materials to you).

Ownership of any software developed or modified by BellSouth and all graphics, text or other information or content

materials supplied or furnished by BellSouth for incorporation into your personal Website, shall remain with BellSouth

(or the party which supplied such materials to BellSouth), and may be used only while you are obtaining the personal

Webpage feature from BellSouth. The domain name and address (URL) granted to you for use with the personal Webpage

feature shall remain the property of BellSouth, shall be used by you only so long as you are obtaining the personal

Webpage feature from BellSouth hereunder, and may be subject to change by BellSouth or the InterNIC or other applicable

Internet domain name registry or granting authority from time to time. BellSouth reserves the right to approve the

subscriber Uniform Resource Locator (URLs) that will be used in conjunction with a BellSouth registered domain name and

personal Webpage feature. URLs registered using a BellSouth owned domain name are nontransferable by subscribers
upon account termination and will be retained by BellSouth.

c. You acknowledge and agree: (i) that the primary function of BellSouth’s personal Webpage feature as it relates to your

personal Website is to facilitate access by end users to the information provided through your personal Website; (i) that
BellSouth has no proprietary, financial, or other interest in any of the content or information that may be described in or
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14.

made available through your personal Website; and (iii) that you are solely responsible for the content, quality, performance,
and all other aspects of the information or other content contained in or provided through your personal Website. You
warrant that you will own or have the right to use and offer all such information or other content in the manner in which
the same will be used, offered or provided in connection with your personal Website. You shall indemnify and hold harmless
BellSouth from and against any and all claims, demands, actions, causes of action, suits, proceedings, losses, damages,
costs, and expenses, including reasonable attorneys fees, arising from or relating to your personal Website or an end user’s
use thereof, or any act, error, or omission of yours in connection therewith, including, but not limited to, matters relating

to incorrect, incomplete, or misleading information; libel; invasion of privacy; infringement of a copyright, trade name,
trademark, service mark, or other intellectual property; or violation of any applicable law.

DISPUTE RESOLUTION - INDEPENDENT ARBITRATION.

PLEASE READ THIS SECTION CAREFULLY. THIS SECTION SETS FORTH THE PROCEDURE FOR THE RESOLUTION OF DISPUTES

THROUGH FINAL AND BINDING ARBITRATION BEFORE A NEUTRAL ARBITRATOR INSTEAD OF IN A COURT BEFORE A JUDGE OR

JURY OR THROUGH CLASS ACTION.

a. BINDING ARBITRATION. THE ARBITRATION PROCESS ESTABLISHED BY THIS SECTION IS GOVERNED BY THE FEDERAL ARBITRATION
ACT (“FAA"), 9 U.S.C. §§ 1-14. IF YOU HAVE A DISPUTE THAT MEETS THE SMALL CLAIMS COURT REQUIREMENTS IN THE STATE
IN WHICH YOU RECEIVE SERVICE, YOU HAVE THE RIGHT TO TAKE SUCH DISPUTE TO SMALL CLAIMS COURT RATHER THAN
ARBITRATION. ALL OTHER DISPUTES ARISING OUT OF OR RELATED TO THIS AGREEMENT (WHETHER BASED IN CONTRACT, TORT,
STATUTE, FRAUD, MISREPRESENTATION OR ANY OTHER LEGAL OR EQUITABLE THEORY) SHALL BE RESOLVED BY FINAL AND
BINDING ARBITRATION. THIS INCLUDES ANY DISPUTE BASED ON ANY PRODUCT, SERVICE OR ADVERTISING HAVING A
CONNECTION WITH THIS AGREEMENT AND ANY DISPUTE NOT FINALLY RESOLVED BY A SMALL CLAIMS COURT. THE ARBITRATION
WILL BE CONDUCTED BY ONE ARBITRATOR USING THE PROCEDURES DESCRIBED IN THIS SECTION. IF ANY PORTION OF THIS
DISPUTE RESOLUTION SECTION IS DETERMINED TO BE UNENFORCEABLE, THEN THE REMAINDER SHALL BE GIVEN FULL FORCE
AND EFFECT.

THE ARBITRATION OF ANY DISPUTE INVOLVING $10,000 OR LESS SHALL BE CONDUCTED IN ACCORDANCE WITH THE ARBITRATION
RULES FOR THE RESOLUTION OF CONSUMER-RELATED DISPUTES OF THE AMERICAN ARBITRATION ASSOCIATION (‘AAA’), AS
MODIFIED BY THIS AGREEMENT, WHICH ARE IN EFFECT ON THE DATE A DISPUTE IS SUBMITTED TO THE AAA. THE AAAS
COMMERCIAL ARBITRATION RULES AND FEE SCHEDULES WILL APPLY TO ANY DISPUTES IN EXCESS OF $10,000. YOU HAVE THE
RIGHT TO BE REPRESENTED BY COUNSEL IN AN ARBITRATION. IN CONDUCTING THE ARBITRATION AND MAKING ANY AWARD, THE
ARBITRATOR SHALL BE BOUND BY AND STRICTLY ENFORCE THE TERMS OF THIS AGREEMENT AND MAY NOT LIMIT, EXPAND OR
OTHERWISE MODIFY ITS TERMS. YOU MAY REQUEST A COPY OF THE AAA'S ARBITRATION RULES BY WRITING TO BELLSOUTH
TELECOMMUNICATIONS, INC., ATTENTION: E-COMMERCE PARALEGAL, 675 W. PEACHTREE STREET, SUITE 4300, ATLANTA, GA 30375,
OR FROM THE AAA AT WWW.ADR.ORG.

NO DISPUTE MAY BE JOINED WITH ANOTHER LAWSUIT, OR IN AN ARBITRATION WITH A DISPUTE OF ANY OTHER PERSON, OR
RESOLVED ON A CLASS-WIDE BASIS. THE ARBITRATOR MAY NOT AWARD DAMAGES THAT ARE NOT EXPRESSLY AUTHORIZED BY
THIS AGREEMENT AND MAY NOT AWARD PUNITIVE DAMAGES OR ATTORNEYS' FEES UNLESS SUCH DAMAGES ARE EXPRESSLY
AUTHORIZED BY A STATUTE. YOU AND BELLSOUTH TELECOMMUNICATIONS, INC. BOTH WAIVE ANY CLAIMS FOR AN AWARD
OR DAMAGES THAT ARE EXCLUDED UNDER THIS AGREEMENT.

. ARBITRATION INFORMATION AND FILING PROCEDURES. BEFORE YOU TAKE A DISPUTE TO ARBITRATION OR TO SMALL CLAIMS
COURT, YOU MUST FIRST CONTACT A BELLSOUTH INTERNET SERVICE CUSTOMER SERVICE REPRESENTATIVE AT THE NUMBER
POSTED ON THE BELLSOUTH FASTACCESS WEBSITE, OR WRITE TO US AT BELLSOUTH TELECOMMUNICATIONS, INC., ATTENTION:
GENERAL COUNSEL — BROADBAND AND INTERNET SERVICES, 675 W. PEACHTREE STREET, SUITE 4300, ATLANTA, GA 30375, AND
GIVE US AN OPPORTUNITY TO RESOLVE THE DISPUTE. SIMILARLY, BEFORE BELLSOUTH TELECOMMUNICATIONS, INC. TAKES A
DISPUTE TO ARBITRATION, WE MUST FIRST ATTEMPT TO RESOLVE IT BY CONTACTING YOU. IF THE DISPUTE CANNOT BE
SATISFACTORILY RESOLVED WITHIN SIXTY DAYS FROM THE DATE YOU OR BELLSOUTH TELECOMMUNICATIONS, INC. IS NOTIFIED
BY THE OTHER OF A DISPUTE, THEN EITHER PARTY MAY THEN CONTACT THE AAA IN WRITING AT AAA SERVICE CENTER, 2200
CENTURY PARKWAY, SUITE 300, ATLANTA, GA 30345-3203, AND REQUEST ARBITRATION OF THE DISPUTE. THE ARBITRATION WILL
BE BASED ONLY ON THE WRITTEN SUBMISSIONS OF THE PARTIES AND THE DOCUMENTS SUBMITTED RELATING TO THE DISPUTE,
UNLESS EITHER PARTY REQUESTS THAT THE ARBITRATION BE CONDUCTED USING THE AAAS TELEPHONIC, ON-LINE, OR
IN-PERSON PROCEDURES. ADDITIONAL CHARGES MAY APPLY FOR THESE PROCEDURES. ANY IN-PERSON ARBITRATION WILL BE
CONDUCTED AT A LOCATION THAT THE AAA SELECTS IN THE STATE OF YOUR PRIMARY RESIDENCE (IF YOU ARE A RESIDENTIAL
CUSTOMER OR PLACE OF BUSINESS (IF YOU ARE A BUSINESS CUSTOMER). ANY ARBITRATION AND ITS RESULT SHALL REMAIN
CONFIDENTIAL. NEITHER YOU NOR BELLSOUTH TELECOMMUNICATIONS MAY DISCLOSE THE EXISTENCE, CONTENT, OR RESULTS
OF ANY ARBITRATION OR AWARD, EXCEPT AS MAY BE REQUIRED BY LAW, OR TO CONFIRM AND ENFORCE AN AWARD.

c. FEES AND EXPENSES OF ARBITRATION. YOU MUST PAY THE APPLICABLE FILING FEE WHEN YOU SUBMIT YOUR WRITTEN REQUEST
FOR ARBITRATION TO THE AAA. ARBITRATOR COMPENSATION IS NOT INCLUDED IN THE INITIAL FEE AND, UNLESS THE PARTIES
AGREE OTHERWISE, WILL BE ALLOCATED BY THE ARBITRATOR IN THE AWARD. UNLESS APPLICABLE SUBSTANTIVE LAW PROVIDES
OTHERWISE, EACH PARTY WILL PAY ITS OWN EXPENSES TO PARTICIPATE IN THE ARBITRATION, INCLUDING ATTORNEY'S FEES
AND EXPENSES FOR WITNESSES, DOCUMENT PRODUCTION, AND PRESENTATION OF EVIDENCE. THE PREVAILING PARTY MAY,
HOWEVER, SEEK TO RECOVER THE AAA'S FEES AND THE EXPENSES OF THE ARBITRATOR FROM THE OTHER PARTY.

General.

a. BellSouth shall not be responsible for any delay in delivery or performance of any of its duties hereunder due to acts of
God, acts or omissions of any regulated telephone network or any other occurrence commonly known as force majeure.

b. Your right to use the Service is not transferable and is subject to any limits established by BellSouth, and by your credit
card company if billing is through a credit card.

c. No action, regardless of form, arising out of the Service or this Agreement may be brought by you or any party claiming
by, through or under you more than one year after the cause of action has arisen.

d. This Agreement and the Service shall be governed by the laws of the State of Georgia, without regard to its conflicts of laws
provisions. If any provision or provisions hereof shall be held to be invalid, illegal, or unenforceable, the validity, legality,
and enforceability of the remaining provisions shall not be in any way affected or impaired thereby.

e. This Agreement and any modifications published by BellSouth over the Service constitute the entire and only agreement
between you and BellSouth with respect to the Service and supersede all other communications and agreements with
regard to the subject matter hereof. Your use of the Service is also governed by BellSouth's Acceptable Use Policies
applicable to the Service, which are available online via the Service and which are subject to change by BellSouth from
time to time.
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f. You are responsible for and must provide all telephone and other equipment, software (other than any browser software
that may be provided by BellSouth) and services necessary to access the Service, including any interexchange (interLATA)
long distance service, which must be provided by the carrier or other provider of your choice.

g. Because of current legal restrictions, BellSouth's Service includes direct connectivity only to information sources or service
providers within specified calling areas known as LATAs. In order to connect to Internet-based services or other parties,
networks or sites located outside of the local LATA (including the world-wide Internet) through BellSouth's Service, you will
need to obtain interLATA Internet service (where available) from a Global Service Provider (“GSP”) of your choice who is
connected to BellSouth's Service. Information about which GSP’s are connected to the Service from time to time may be
obtained online on the Service or by contacting BellSouth. You are responsible for choosing such a provider and for paying
all applicable charges for such GSP's service, as well as all charges for any purchases made through the Service and any
charges incurred while using any supplemental networks or services other than the Service. BellSouth will facilitate the
process of registering your account with the available GSP of your choice, and that provider’s charges may be included
on your bill from BellSouth. Any computer system, database access, Internet connection or other services which may be
provided or made available to you by your GSP or any other party are the sole responsibility of and at the sole discretion
of such party, and are not included in or a part of BellSouth's Service. BellSouth makes no selection, endorsement or
recommendation with respect to any GSP or other interexchange long distance service provider, Internet access provider
or other aspect of any service provided by the GSP or other party, and BellSouth shall have no responsibility, obligation or
liability of any nature with respect thereto. The reliability, availability and performance of resources accessed through the
Internet or other services connected to BellSouth's Service are beyond BellSouth's control and are not in any way warranted
or supported by BellSouth. You acknowledge that safeguards relative to copyright, ownership, decency, reliability and
integrity of content may be entirely lacking with respect to the Internet or other services or content accessible through
BellSouth's Service. You assume all risk and liability of your use of the Internet or other services or content accessible
through BellSouth’s Service, including your continuous compliance with this Agreement.

THIS PAGE CONTAINS INFORMATION PERTAINING TO BELLSOUTH® INTERNET SERVICE. THE INFORMATION ON THIS PAGE MAY NOT APPLY
TO PEOPLE WHO USE ANOTHER INTERNET SERVICE PROVIDER.

Copyright 2002 BellSouth Telecommunications, Inc. All Rights Reserved. Legal Notices and Privacy Statement.
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